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Welcome to Positive Pay

A. Service Overview

Positive Pay is a check positive pay service designed to empower account holders (our “Customer”) with the ability to
prevent financial loss due to check fraud. This guide is intended to provide information to Customers in choosing and

using the level of protection best suited for their needs.

B. Introduction to Positive Pay

1. This guide will outline all Positive Pay functionality, but it is important to note that some features will only be
available if the feature has been enabled by the Bank and/or the user has been granted the appropriate user

privilege required to access the feature.

2. The table below lists the Positive Pay types available for each account enrolled in Positive Pay, a description of
expected behavior and protection level ranking. Positive Pay relies on Customers to make daily decisions, when
required, for the check activity that occurs on their account. When accounts are enrolled, a default setting can
be established for the system to return or pay a transaction if the user fails to do so by the established end-of-
day cut-off time. The last column in the table defines the default settings available for each type of positive pay

service.
Positive Pay Service Description Default Setting
Type Options
This service requires the Customer to provide a list of checks that
have been issued or voided on an account (Issue Items). The issue
Standard items for each account must include, at a minimum, a check serial
o number, amount, and status (issued, voided, stopped). The Bank Pay or Return
Positive Pay

compares each check presented for payment (Item) against the list
of issue items. If an exception is identified, designated users are
alerted to make a pay or return decision.

Payee Positive
Pay

Customers are required to provide the payee name for each issue
item. The Bank will compare the name in the issue item against
the name that appears on the “Pay to the Order of” line of the
check presented for payment. A scoring method will be used to
determine the likelihood of a match, and if the score falls below
the established threshold, the item will be flagged as an exception.
It is important to note that payee name scoring is subject to a lot
of variables. Scoring can fail items that should pass if customers
fail to perform best practices. Refer to Section VIII. Payee Positive
Pay Tips & Best Practices for more information.

Pay or Return

2\T1N
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Support
Multiple Payee
Names

Positive Pay has the ability to accept multiple payee names in an
issue item file and validate multiple payee names on checks
presented for payment. Multiple payee names can be placed on a
single line or multiple lines.

Pay or Return

Reverse
Positive Pay

This service does NOT require customers to provide a list of issued
items. Customers will need to login every day to view checks
presented for payment and select the checks they want to return
because the concept of an exception does not exist since there is
no list of issue items to compare items against. However,
Customers may request the Bank establish a maximum check
amount per account (Exception Limit). If this optional setting is
enabled, an alert will be sent to designated users ONLY when a
check is presented that exceeds the maximum amount
established.

Pay

3. Positive Pay offers alerting (notification) to call designated users to action when required. Positive Pay is

designed to ensure notifications are relevant, but each Customer can advise the Bank of notification levels that

best suit their needs.

4. The table below outlines a list of events that trigger an alert to a Customer, a description of the triggering event

and if the alert type is Standard or Optional.

Alert Type

Description

Exception Alert

enrolled in Reverse Positive Pay.

Occurs when a check is presented for payment that does not match the
issue information provided or if an exception limit is set on an account

Issuance File Load
Alert

item failed due to errors.

Occurs when an issue file is loaded. The alert contains status
information to indicate if the issue item loaded properly or if the issue

Issue File Pending

Occurs when an issue file has been loaded and is being held in
Approval “Suspended” status until approved by a secondary user.

Decision Approval
Required

Occurs when check transaction decisions require a secondary approval.

2\T1N
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5. When an account is enrolled for Positive Pay, one of three levels of notification can be established for exception
alerts. The notification level options and descriptions are provided in the table below. Email alerts are standard.
Customers can also elect to receive text alerts.

Notification Level Description

Transaction Alerts One alert for each exception identified.

Account Alerts One alert per account when one or more exceptions are identified.

Service Alerts One alert per user when one or more exceptions are identified on one or more accounts.

Accessing Positive Pay

Open an internet browser and visit fidelitybanknc.com. Then click the blue login button in the top right corner to log in
to Business Online Banking. Once logged in to Business Online Banking, click on Accounts, then click Fraud Prevention.

A

= Fideli
’, delity Bank
Accounts ~ Transfers ~

Account Summary

Statements &
Motices

Stop Payments

WebConnect

Fraud Prevention

AL AT TAETIMMA 1~
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The next screen will inform you the platform will open a new window to establish a connection with the ACH Filter,
Positive Pay, and EDI platform. Click Continue.

i

***if your browser, has a pop-up blocker, please disable to continue

’{FldehtyB I eJern Foster v | Print | Chat | LogC
4 Right By You

FDIC Froicinsured—Backed by the full faith and credit of the U.S. Governmi

Accounts ~ Transfers ~ Payments Cards Zelle® ACH ~ Wires ~

Fraud Prevention Services

We are establishing a connection to the ACH Filter, Positive Pay, and EDI platform. This platform will open in a new window. If your browser has a pop-up blocker,

please disable it to continue.

You are now on the landing page of Positive Pay. Please proceed as normal.

= Fidelity Bank

Right By You"

Dashboard  # Perform « shReports » = Transaction View Change Module ~ &

ACH Filter Credit

End of Day Cut-Off Time: Monday 12:00 PM EDT

Total ACH Credits $0.00 ©  Pending Approval $0.00 (0]
Set to Pay $0.00 ©  settoRetun $0.00 (0]
Approved List Exceptions $0.00 ©  Block List Returns $0.00 0

Fnd af Dav Cut-0ff Time* Mandav 12:00 PM FNT

POSITIVE PAY DASHBOARD BOX

A. Using the Dashboard
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1. The Dashboard is the default landing page within the portal. If Positive Pay is enabled, a Positive Pay box will be
displayed. Summary information on current check transactions and status will be displayed for accounts the user
has been granted access. Active links are embedded within the Positive Pay box to permit users to navigate from
the dashboard landing page into the Positive Pay service module or directly to transactions in the status
selected. Dashboard totals are updated in real time as transaction status values are changed by a user.

The content displayed in the Positive Pay summary box includes the following:

Positive Pay

Exceptions $0.00

Set to Pay

$0.00 (0] Set to Return $0.00

End of Day Cut-Off Time: Friday 12:00 PM EST

©  Pending Approval $0.00 o
0]

Service Name

End of Day Cut-Off Time

Exceptions

Pending Approval

Set to Pay / Set to Return

Clicking Positive Pay on the left in the title bar will direct the user to the main menu.

The time of day indicates when transactions that require decisions will no longer be
eligible for user decisions.

Clicking on the dollar amount hyperlink on the Exceptions line will direct the user to a
filtered view of Transaction History that will display only exceptions that require a
decision.

If Dual Decision Approval has been enabled, the Pending Approval hyperlink will appear
in the Dashboard. Clicking on the dollar amount hyperlink on the Pending Approval line
will direct the user to the Check Transaction Approval screen, where the user can
approve or reject any transactions that are pending approval by the user. For more
information about Decisioning Dual Approval, please refer to Section Vi, Decision
Dual Approval.

Clicking on the dollar amount hyperlinks on the Set to Pay or Set to Return lines will
expand the view to display a breakdown of the total for each category. System Pay or
Return indicate transactions that will pay or return if no action is taken due to the
default status. User pay or return indicate a User decision has occurred. Fl pay or return
indicate the Bank decision has occurred on behalf of the Bank
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Transaction History
Mass Pay & Issue
Y Filters
Transaction ID Account Number
> 49129 00061111
> 49128 00x1111
> 49127 3000¢1111
> 49126 00061111
> 49125 0001111

Serial Number

12274

12274

12273

12272

12271

181 debit transactions totaling $261,203.62

Rows 1-250f 181,

Credit Debit Current Status

$127.00  Pay-System

$27.00 Pay-System

$35.10  Pay-System

$20.00 Pay-System

$200.00 Pay-System

Dateli

08-31-2021

08-31-2021

08-31-2021

08-31-2021

08-31-2021

Date Range

SAuguUSt 1, 2021 - August 31, 2021~

Change Status

® Return

® Return

® Return

® Return

® Return

Transaction History

Exception

(1]

i

The user can click on the dollar amount link for any category to be directed to a filtered

view of the Transaction History. In the above example, the user has clicked on the dollar
value of Exceptions on the Dashboard and is directed to a view of exception transactions
that require decision.

Please refer to Section VI, Subsection A, Transaction History, for more information on this
function.

2. From the Client Dashboard, a user can navigate to the Positive Pay Module by clicking Change Module > Positive

Pay

Dashboard ~ # Perform ~

diReports +  i= Transaction View

ACH Filter Credit

End of Day Cut-Off Time: Friday 12:00 PM EST

Change Module »

ACH Filter Debit
Positive Pay
EDI TransAlert
ACH Filter Credit

MANAGING ISSUE ITEMS

Certain types of positive pay services require Customers to maintain a list of issued items for the Bank to compare
presented items against so exceptions can be identified.
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While issue items can be added after a check has been presented for payment, it is highly recommended that Customers
enter or load issue items prior to disbursing paper checks to payees, as failure to do so could result in denial of payment
if the check is presented at the teller line for deposit or to be cashed.

When an issued item is entered or loaded into Positive Pay, the status and disposition of the issued item is tracked.

The table below describes the status and disposition labels associated with issue item management.

Labels Description
Issued A status defined by the Customer that indicates a check was issued.
Voided A status defined by a Customer that a check was issued but later voided and not distributed.
Stopped A status defined by a Customer or designated by the Bank if the Bank chooses to control this
PP status.
Available for Matching A .status assigned by the Positive Pay system when an issue item is entered or loaded by a
Client.
, , A status assigned by the Positive Pay system when a check is presented for payment with a
Used in Matching ) & v . s . . ? e
serial number that matches a serial number for an issued item.
, A status displayed in the issue warehouse that indicates a check has not yet been presented
Outstanding . . L . .
for the issued item and it is still available for matching.
Paid A status displayed in the issue warehouse that indicates a check has been presented against
an issue item and it was paid by the system, Customer or Bank.
A status displayed in the issue warehouse that indicates a check has been presented against
Returned . . .
an issue item and it was returned by the system, Customer or Bank.
A status assigned by the Positive Pay system when an issue item that has not been used in
Purged Matching (outstanding) has been removed from the system. The purge period is defined by
the Bank.
A status value displayed in Issue File Status that indicates that a file that was loaded was
Deleted deleted by a Customer or Bank user. A history of the file load and delete action are retained

but the issue items are removed as if they were never introduced to the system.
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If an issue item is updated after it was loaded, history will be available in the issue item

Updated warehouse when the drop-down for an issue item is expanded.

A. Test Mode

Customer can request the Bank enroll accounts with an inactive status and grant users’ access to the system to test issue
file load. Issue items loaded while in test mode are marked as test issue items and will not be displayed in the issue
warehouse or used for matching against presented checks. Customers must notify the Bank when testing has been
completed and they wish the account to be active.

B. Status Values
Issued items can have a status of Issued, Voided or Stopped.

1. Issued: The check has been issued and distributed for payment.

2. Voided: The check has been voided by the maker. A check is usually voided prior to disbursement. A voided
check cannot be used to make a payment or withdraw money from the account.

3. Stopped: A check that has a stop payment placed on it. A stop payment is placed by a financial institution to

cancel a check that has not yet been processed.
4. Disable Stop Payments: The Bank may choose to Disable Stop Payments in their configuration settings. The FI
may choose to do this because they prefer to update those items in their core banking system.

If stop payments are enabled, the client user can:
e Load issue files with stopped status items
e QOverwrite via Manual Issue Entry to change an item from Stopped to Issued or Voided
e Change a previously Stopped item to Issued or Voided via Issue Warehouse

If stop payments are disabled, the client cannot:
e Load issue files with stopped status items
e QOverwrite via Manual Issue Entry to change an item from Stopped to Issued or Voided
e Change a previously Stopped item to Issued or Voided via Issue Warehouse.

C. Manual Entry

Customers can manually enter a list of checks that have been issued. To manually enter an issue item, the user must be
granted the manual issue entry user privilege. Note: Positive Pay will not accept issued items with a date more than two

years in the past.

The table below describes a list of fields that may be displayed in the manual entry screen, the criteria for the field to
display and how the information entered will be used to identify exceptions when matching issue items to checks

presented for payment.
10
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Field Criteria Use
To identify if the check was
Serial # The check number/serial # is always required. issued or presented more than
once.
. . Used to identify if th t of
Amount A dollar value is always required. Sed to identily I the amount o
a check has been altered.
The person(s) or entities to whom the check was intended to pay. The . . .
) B . (s) . . pay Used to identify if the name in
Payee field will support entry of multiple payee names (maximum of 4 " 1
e » e . the “Pay to the order of” line has
Name allowed) by clicking “Enter” to input another name on the next line.
been altered.
Each check should be accounted for, even checks that have been
voided or have had a stop payment issued. The status value advises Used to determine if a check
the Bank if a check has been issued and distributed, issued, later should be analyzed for matching
Status voided and not distributed or issued, distributed and stop payment (issued) or if a check was
order was requested later. The issued and void status values will presented for payment that was
always be available for selection. The stopped status will only appear previously voided or stopped.
if the Bank has enabled this option for Client designation.
A date the check was issued and valid for payment is always required. | Used to determine if a check is
Issuance . . . .
The issuance date will always default to the current date, but the user | presented earlier than intended
Date .
can assign a back or future date. or later than allowed.
Additional Only avail.a.ble if 'the Iss'ue Templatgs user privi'lege is turned on ff)r a Used for account reconciliation
user. Additional issue fields are typically used if a Customer requires L
Issue e . . . . purposes. Example: An invoice #
, Positive Pay to retain information related to the issued item for . .
Fields e associated with a check.
reconciliation purposes.

1. From the Positive Pay module, click Perform > Manual Issue Entry.

Positive Pay

£ Manage ~ = # Perform ~  JiReports ~ = View ~

Issue File Load
Manual [ssue Entry.

come

Transaction Approval

Please use the above menu to select an action

11
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2. The Manual Issue File Entry screen appears.

Manual Issue Entry

Account? Auto populate next check number:

- not selected - v

Row Serial Number Amount Payee Name’ Status Issuance Date

ISSUED ~ 03/03/2021

@ Click any row to select that row for editing

Save

Account Select appropriate Account Number from the drop-down menu.

Auto populate next When checked, the next check number will auto-populate in the following row. This feature is
check number designed to eliminate serial number entry when checks are issued in sequential order.

When unchecked, the next check number will remain blank until it is filled in by the user.
Row Each issue item will be numbered in the order they are entered. Once the cursor is placed in
the current row, an additional row will appear for the next entry.

Serial Number Type the item serial number for this manual issuance file in the Serial Number field.

Amount Type the dollar amount for this manual issuance file in the Amount field. Or use the up and
down arrows in the Amount field to select a dollar amount.

Payee Name Type the payee name for this manual issuance file in the Payee Name field. The Payee Name

field supports the entry of a single payee, or multiple payees.

Please see Step #3 below for in-depth information about the Payee Name field and Multiple
Payee Names.

Status Issued The check has been issued.
Voided The check has been voided by the maker.
Stopped The check has had a stop payment placed on it.

It is important to note that if the Bank has disabled stop payments, the Stopped status
option will not appear in the drop-down menu.

12
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3. Payee Names: The Payee Name field supports up to four Payees.

a. Click within the Payee name field to enter Payee Name(s).

TN

Click on the Issuance Date field and select a date from the calendar that this item was issued.

Row Serial Number Amount Payee Name’

10100 300.00

ISSUED

Status

v & | 03/03/2021

Issuance Date

b. The view size on the Payee Name field can be enlarged by dragging bottom right corner of field box. The

feature may not be available based upon the browser used.

Row Serial Number Amount Payee Name’

10100 300.00

Status

ISSUED 2 =

Issuance Date

03/03/2021

c. Input the Payee Name in the field. If there are multiple payees, an Enter (carriage return) must be used to
input a second, third or fourth payee on separate lines in the field for it to be distinguished as different

payees.

Row Serial Number Amount Payee Name’

10100 Helen Jones & Lisa Mi\leri

300.00

Status

ISSUED v =

Issuance Date

03/03/2021

If multiple payees are listed on a single line of the check, putting them on separate lines is not applicable.

d. The Payee Name field currently supports 500 characters in total. This count will include the carriage returns
separating multiple payees. The 500-character limit is for the entire field, and not per payee.

It is important to note that although 500 characters are allowed in this field, names might be truncated if
using a fixed width template and the number of characters allowed in that column are less than 500.

4. To edit any row, click in the fields to be edited and make changes.

13
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< Back to Status MANUAL_1617197309551

File Status

Queued Processed Approved Completed Deleted

File processing is complete. View list below to see items.

® View items: 2 Items totaling $80,001.00 Load Date: 03/31/2021 09:28:29 EDT
Rows 1-20f2.
Account Number Serial Number Amount Payee Name Status Issuance Date
o111 40000 $40,000.00 Formula 1 AVAILABLE_FOR_MATCHING 03/31/2021
xxxx1111 40001 $40,001.00 Lewis Hamilton AVAILABLE_FOR_MATCHING 03/31/2021

Delete

5. When all manual issuance files have been entered, click Save button.

6. The Manual Issuance File Status detail page appears.

Load Date Date and time the file was loaded.

Account Number The account number on each issue item.

Serial Number The serial number of the issue item.

Amount The amount of the issue item.

Payee Name Name of the payee(s) from the issue item.

Status Available_For_Matching The issued item is available for exception matching against an

incoming check.

Duplicate Issuance This issued item is a duplicate and has already been issued.
Used in Matching This issued item has been used in the exception matching

against an incoming check.
Issuance Date Date the item was issued.

14
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7. Click the Back to Status button to view the Issuance File Status page. For more information, please refer to
Subsection G, Issue File Status.

8. Issuance Dual Approval:

Some clients may have the optional Issuance Dual Approval feature enabled, if offered by the Bank. In this
circumstance, manual entry files must be approved by a second client user or, if no second user is available to
approve the file, the client can request the Bank approve the issue file.

Please refer to Subsection H. Issuance Dual Approval for more information about the Issuance Dual Approval
process.

9. Disable Stop Payments: Users cannot create new stopped issue items or modify previously stopped issue items.
The Bank can, however, feed stop pay items from the core banking system.

a. If a user attempts to create a manual entry item with a serial number the Bank has loaded a stop pay on, the
system will not accept the item.

< Back to Status MANUAL_1614874619362
File Status
Queued Processed Approved / Rejected Completed Deleted
Some items are ineligible. View list below to see items. Remove ineligible items and reload file
@ view items: 3 Items totaling $1.375.00 Load Date: 03/04/2021 11:16:59 EST
Rows 1-30f3.

Account Number Serial Number Amount Payee Name Status Issuance Date
Xxx3232 100945 $525.00 Moe Green INELIGIBLE_FOR_MODIFICATION 03/04/2021
003232 100946 $500.00 River Rouge INELIGIBLE_FOR_MODIFICATION 03/04/2021
003232 100949 $350.00  Margaret Anjou INELIGIBLE_FOR_MODIFICATION 03/04/2021

D. Issue Templates

The purpose of issue templates is to make it easy to load issue items into Positive Pay using files that can be
generated out of most accounting systems. Positive Pay provides organizations a variety of flexible options for
providing a list of checks that have been issued or voided.

15
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Issue templates allow users to select from a list of file formats supported and identify where the required data
elements are located within the file.

Once a template has been set up, the template can be selected when loading a file to tell Positive Pay how to
utilize the data contained in the file.

Multiple file templates can be set up, displayed and used.

1. From within the Positive Pay module, click Manage > Issue Templates.

Positive Pay = #Manage ~  # Perform ~  JiReports ~ = View ~

Issue Templates

Welcome

Please use the above menu to select an action

A screen will appear that lists any existing templates that are available for view or edit, and a button to
Create New Template. NOTE: Templates created by the Bank cannot be modified by a Customer. Templates
created by the Customer can be modified by the Customer and the Bank. Templates created by the Bank can
be viewed by clicking the eye icon in the Edit/View column.

Template File Type
Delete EditView

2011 Regression C Comma Separated @
sV Comma Separated @
sVl Comma Separated @
DBFI Fixed Width Fixed Width @
Excel 1 Excel Workbook @
Excel §7-2003 Workbook Excel 97-2003 Workbook @
Quickbooks Type 1 Excel Workbook @

[m} 2008 Regression Comma Separated v

(] 2008 Regression A Excel Workbook 7

2. Toview or edit an existing template, click the pencil icon for the appropriate template.

3. To delete an existing template, click the checkbox next to the Templates to be deleted and click Delete Selected.
Templates that have the Delete option were built by the Customer and can be deleted/edited by the user.
Templates without the Delete option were built by the Bank and cannot be deleted/edited by the Client user.
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4. To create a new template, click the Create New Template button.

Create New Template

Template Name File Type’ Template Status
- select file type v Active v

Number of Header Rows’ Number of Footer rows’ Template Level’
0 0 Client v

Multi-Line Payee Name Separator: ?

Do not use a character as a separator if

The upper portion of the template screen will not change, regardless of the file type selected. The template
name, file type and template status values are required. The header and footer fields are optional.

Many accounting systems can export excel or fixed width files. Sometimes those files have header (beginning)
rows or footer (ending) rows that contain data that is not required by Positive Pay.

When setting up a template, the Customer can define the number of rows Positive Pay should ignore at the
beginning and end of the file. It is important to note that if the values are entered incorrectly, an issue file may
load with errors or no items.

About Multi-Line Payee Name Separator:

The Multi-Line Payee Name Separator field is optional. This feature allows the Bank to enter a character that
can be used to separate Multiple Payee Names that are on separate lines of an issued check.

Currently, the system restricts the allowed characters to the following: ; | , - _ /. The user must be aware
that using a separator character that appears elsewhere in the payee name or might conflict with the file itself
can cause issues. Examples of scenarios where problems might arise are listed below.

Within a Comma Separated file (.csv), different data fields are separated by a comma. Therefore, a comma
cannot be used in the data field itself, or the .csv will read the comma as a separator before the next field.
Therefore, listing two payees for an item in this way: “Elain Archeron,Nesta Archeron” will cause issues
reading the .csv file. In this scenario, the user should select a multi-line payee name separator character that
will not cause an issue, such as a semicolon. “Elain Archeron;Nesta Archeron” in the Payee Name field of the
.csv file will process correctly.
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If the user selects a separator character that would ever appear in a payee name field, such as a dash (-), the
system would then separate the data before and after the character as separate payees. For instance, if the
user has selected a dash (-) as the Multi-Line Payee Name Separator, and a common payee used is “In-and-
Out Burger”, the system will flag this as having multiple payees. In this case, the user should select a multi-line
payee name separator that will not cause such issues, such as a pipe (|) or a semicolon for cases of multiple
payee names.

Please refer to Section VIII Payee Positive Pay Tips & Best Practices for more information about multiple
payee name handling.

The mapping section below will display based on the file type selected. It is important to note that not all
fields/options seen in these graphics may be available based on settings configured by the Bank.

Excel and separated files will require Customers to define the column data elements that will be found.

Create New Template

Template Name File Type’ Template Status
- select file type b Active b

Number of Header Rows’ Number of Footer rows’ Template Level®
Q 0 Client e

Multi-Line Payee Name Separator: ?

Do not use a character as a separator if
that character will ever be presentin a
Payee Name, Allowed charactersin
brackets[; | ,-_/1

This Client has not been setup for client additional issue fields in templates.

Configure in Client level settings and setup client additional issue fields for the Client and try again.
File Mapping
Add Input Field” File Column’ Field Format
Serial Number

Amount’ ® Fractional Dollars (12.34)
O Whole numbers of cents (1234)

Status’ 1SSUED - for ISSUED

STOPPED - for STOPPED
~for v

VOIDED or VOIDED

O Account Number?

O Issuance Date’

O Payee Name’

(m] Routing Number’

c *- Place the cursor over this label for more information
Save
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Fixed Width files will require the Customer to define the start and end position in which the data element is
located.

Create New Template

Template Name File Type’ Template Status
Fixed Width b Active hd

Number of Header Rows’ Number of Footer rows’ Template Level
0 0 Client hd

Multi-Line Payee Name Separator:

Do not use a character as a separator if
that character will ever be present in a
Payee Mame. Allowed characters in
brackets [ |, -_/]

This Client has not been setup for client additional issue fields in templates.

Configure in Client level settings and setup dlient additional issue fields for the Client and try again.
File Mapping
Add  Input Field’ Start Position’ End Position” Field Format

Serial MNumber

Amaount’ ® Fractional Dollars (12.34)
' Whole numbers of cents (1234)

Status’ ISSUED - for ISSUED
STOFFED - for STOPPED
VOIDED - for VOIDED
O Account Mumber?
O Issuance Date’
O Payes Name’
O Routing Number’
= *- Place the cursor over this label for more information
Save
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The mapping section on the lower part of the screen displays the required fields. The Check Serial # and Amount
fields are always required. The Customer must specify if the amount data in the file to be imported will or will
not contain decimal points. For example, if the Amount value is set to Fractional Dollars, then 100, 100.0 and
100.00 are all processed the same. If the Amount value is set to Whole numbers of cents, the system will divide
by 100 and save it as a dollar value. For example, a value of 100 would be saved as $1.00 in the system.

The Customer may choose to import additional data by checking the Add box next to the desired data element.

If the Status box is not checked (as shown below), Positive Pay will load all issue items with a status of Issued. If
the Customer file represents Voided items as a negative number, the Customer can check the box Treat
Negative Amount as Void and Positive Pay will status any item in the file with a negative value as Voided.
Issuance with a S0 amount will also be treated as void.

Create New Template

Template Name File Type’ Template Status
- select file type A Active A

Number of Header Rows’ Number of Footer rows’ Template Level®
0 0 Client hd

Multi-Line Payee Name Separator: *

Do not use a character as a separator it
that character will ever be presentin a
Payee Mame. Allowed characters in
brackets [ ]| .-_/]

File Mapping
Add  Input Field’ File Column? Field Format
Serial Number
Amount’ @® Fractional Dollars (12.34)
O Whole numbers of cents (1234)

O Status’ Treat Negative Amount As Void®
Issuance with 30 amount will be treated as Void
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Create New Template

Template Status

hd Active

Template Name File Type?
Fixed Width
Mumber of Header Rows’ Mumber of Footer rows’

0 0
U v

Multi-Line Payee Name Separator: ©

Do not use a character as a separator if
that character will ever be presentin a
Payee Name. Allowed characters in
brackets[:].-_/]

File Mapping
Add  Input Field” Start Position’ End Position’

Serial Number

Amount?

O Status’

Template Level’

Client

Field Format

() Whaole numbers of cents (1234)

l @ Fractional Dollars {12.34)

Treat Negative Amount As Vioid®
Issuance with $0 amount will be treated as Void

i

If the Customer checks the Status box additional fields will display as shown below. If the Customer’s accounting
system exports issue items with an Issued and Voided status, no additional action is required.

Status’ ISSUED

STOPPED

VOIDED

- for ISSUED

- for STOPPED

- for VOIDED

It is important to note that if the Status box is checked for a template, and this information is not provided in the

issue file loaded, the system will give each record an ISSUED status. In addition, the STOPPED status may not

appear in the Template configuration screen if the Fl has disabled stop payments.

If the accounting system used exports issued items with a value of X and voided items with a value of Y, the user
can identify the values as shown below so Positive Pay can translate the data appropriately when importing the

data.
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Status’

- for ISSUED

- for STOPPED

- for VOIDED

A description has been provided below to define system behavior if additional data elements are included.

Account
#

Issuance
Date

If the account box is selected, the user can import one file that contains issue items for
multiple accounts. If the account box is NOT selected, when a user loads a file through the Client
portal, Positive Pay will require the user to select the account the checks were issued on.

If the issuance date box is NOT checked, Positive Pay will default the issue date to date the file
was loaded. If the issuance date box is checked, the file must contain an issuance date for each
item. For Excel files, Positive Pay will translate the data format used in the file. For separated and
fixed width files, the Customer must define the date format being used as shown in the
screenshot below. It is important to note that the formats displayed are examples only, a
complete list of date formats can be found at:

https://docs.oracle.com/javase/8/docs/api/java/time/format/DateTimeFormatter.html#tpatterns

Issuance Date’

M for month, d for day of month, y for year
Examples:

yyyy-MM-dd for 2019-12-25

MM/ddyy for 12/25/19

MMM dd, yyyy for Dec 25, 2019

Payee Name

The Payee Name box will only appear if one or more accounts are configured for payee
positive pay. If the payee name box is checked, Positive Pay will require the payee
name for accounts configured for payee positive pay. If payee name is provided for
accounts not enrolled in payee positive pay, the payee name data will be ignored when
the file is loaded. For Excel or delimited files, the complete and single payee name is
expected in a single column. For fixed width files, the complete and single payee name
must be contained in the file between the starting and ending position.

If Multiple Payee Names feature is enabled, the Issuance Payee name may display
more than one payee.
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E. Additional Issue Fields
Additional issue fields are not used in any exception matching process. These additional issue fields are
available for Customer use to allow Customers to record additional information into an issuance file to be used
for historical or reconciliation purposes. If this feature is enabled and in use, it will impact the view and behavior
of the Manual Issue Entry and Issue File Template screens. A few examples are shown below.

Manual Issue Entry

Account” Auto populate next check number:
FFFriends - 000¢1111 -
Row Serial Number Amount Payee Name’ Status Issuance Date
£ 8454 233.01 Office Pride ISSUED v | B 05292020
ra
Type: h # Account: 000111111
Internal Ref#: | goonoo —
rssUED " 05/29/2020
ra
@ Click any row to select that row for editing
Save
Create New Template
Template Name File Type’ Template Status
- select file type ~ Active ~
Number of Header Rows’ Number of Footer rows’ Template Level’
o o Client ~
Multi-Line Payee Name Separator:
Do not use a character as a separator if
that character will ever be presentina
Fayee Name. Allowsd characters in
brackets [: -_11
File Mapping
Add  InputField® File Column’ Field Format
Serial Number
Amount’ ® Fractional Dollars [12.34)
O Whole numbers of cents (1234)
Status —— - for ISSUED
JE— -for STOPPED
VOIDED - for VOIDED
(] Account Number?
(m] Issuance Date”
[m} Payee Name’
=] Type —
o Account —
[m] Internal Ref # —
Save: ’- Place the cursor aver this label for more information
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Positive Pay offers the option of creating up to 6 additional issue fields within an issue template.

Additional issue fields 1 and 2 are reserved for use by the Bank to set institution-wide additional issue fields that
can be accessed by all enrolled clients.

Additional issue fields 3 through 6 are available for Customer-specific use and can be tailored to fit the
recordkeeping needs of the individual Customer. These fields can be configured by the Bank at Customer’s
request, or by the user. When this feature is enabled, a client can have up to four Customer-specific Additional
Issue Fields. Both Bank and users are able to delete Additional Issue Fields 3 through 6. Bank Level Additional
Fields 1 and 2 can only be deleted by a Bank user.

Additional issue fields, once set up for customer use, will be displayed as configuration options in any File
Templates that are created or edited. In turn, once enabled, these additional issue fields will be displayed when

viewing file status or transaction status on any issued items.

1. From within the Positive Pay module, click Manage > Additional Issue Fields.

Change Module ~

iii
1']
4

PRO-CHEX £} Manage ~ # Perform ~ i Reports ~

Issue Templates
[ Additional Issue Fields ] _

vveicome

Please use the above menu to select an action

2. The Additional Issue Fields page appeatrs.

Additional Issue Fields

Issue Field’ Label? Delete
FI Global 1 Type

F1 Global 2 Account

=

Client 1 v

Client 2
Client 3
Client 4

@ Click any row to select that row for editing

Save
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Additional Issue Fields

Issue Field” Label? Delete

=1

Client 1 v Internal Ref

- Select One- v

@ Click any row to select that row for editing

Save

Issue Bank Global 1 and Bank Global 2 are reserved for Bank'’s labels. Client-1 to Client-4
Field may be used by the Bank or Customer and are customizable to the Customer. Select
the Additional Issue Field desired by clicking the drop-down menu.

Label The name of the additional issue field the Customer wishes to set up. The label must
be unique to the Customer, and the client labels may not match any labels already
configured by the Bank.

3. Once a Customer clicks the drop-down menu to select an Additional Issue Field, another row will appear so that
further Additional Issue Fields can be added, until all 4 available Additional Issue Fields have been setup.

4. Once all Additional Issue Fields have been created, click Save button to complete the process.

5. Any existing Additional Issue Fields can be edited by clicking on the Additional Issue Field drop-down or by
clicking within the Label field.

6. Any existing Additional Issue Fields can be deleted by clicking the Trash icon in the Delete column on the
Additional Issue Fields page.

7. Once Additional Issue Fields are established, they will be displayed within the Customer’s File Templates, both
existing and new, as a field that can be mapped when submitting Issuance File data. The user should see the
additional issue fields that were set up at the bottom of the list.

8. The Additional Issue Fields will be displayed when Customer submits files via Issuance Manual Entry and are also
displayed when viewing items in the Issue Warehouse.
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F. Loading Issue Files

Note:

The Load Issuance File user privilege must be enabled.

Positive Pay will not accept issued items with a date more than two years in the past.

If Multiple Payee Names feature is enabled, Positive Pay will support more than one payee name in the
Payee Name field of issuance files. Please see Step #2 below for more information.

Issue file loading will strip and ignore dollar signs on dollar amounts, and double and single quotations
around data fields.

For best results, users should not load issue files with mixed account numbers unless they have access to
all the listed accounts. Loading issue files with account numbers for which the user has no access will
cause errors.

Positive Pay allows users to load issue files into the system for use in matching. Positive Pay accepts these files in a
variety of formats, used in conjunction with file templates (covered in the previous subsection).

1. From the Portal:

a.

Positive Pay module, click Perform > Issue File Load

Positive Pay £ Manage ~ # Perform - o Reports ~ i= View »

Issue File Load

Manual Issue Entry
Transaction Approval e | CO m e

Please use the above menu to select an action

b. The Load Check Issuance File page appears.

Issue File Load

Template to Use With Issue File

- select template - v Create New Template

Select template that matches issue file format
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c. Select the Template drop-down box to select from a list of existing templates. Select one of the available
templates listed. If only one template is available for a client, the drop-down box will select that template by
default.

Issue File Load

Template to Use With Issue File

| - select template - v Create Mew Template

- select template -

1224

sV

DBFI Fixed Width

Excel 97-20032 Workbook
Excel Workbook 2
TestTemplated
tester

d. If the template selected was created without the Account field enabled, then a drop-down box will display
so that an Account can be selected. Select from the list of accounts. If only one account is available for a
client, the drop-down box will select that account by default. The file upload interface will appear. Click the
Browse button to select the appropriate file.

Issue File Load

Template to Use With Issue File Account?

Excel Workbook 2 v - not selected - - Create New Template

- not selected -

FFF Escrow - xxxx4444
FFF Expense - xxxx3333
FFF Payroll - xoxxx2222
Select account and template that matches issue file format| FFFriends - 01111

View Selected Template
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Issue File Load

Template to Use With Issue File Account’

Excel Workbook 2 v FFFriends - 00001111 v Create New Template

View Selected Template

Select one issue file that is in the format of the selected template

Select files... "W Browse ...

e. Once the file is selected, it will be displayed in the upload interface.

Issue File Load

Template to Use With Issue File Account’

Excel Workbook 2 v FFFriends - oo 111 v Create New Template

View Selected Template

Select one issue file that is in the format of the selected template

A

[+ ® @ a
B Issue 0529-001.xIsx i Remove =~ @ Upload
Remove The file will be removed from the page.
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Use Browse to locate the file you want to load.

The file will be uploaded.

f. The Status Bar will display the current status of the file.

< Back 1o Status

File Status

Queued Processed Approved / Rejected Completed Deleted

File is processing .. ..

WKP1 Issue 1028-001.xlIsx

g. If errors were encountered during the initial processing of the issuance file, the Parse Errors display will

appear,

allowing the user to view the error detail within the file. The most common reason this error would

appear is because the file contains improper formatting. At this point, the user will have the option to:

This will

Correct those errors.

Delete individual errors. This feature only displays if there are errors in the file and is only available
until errors have been corrected and the file is saved.

Delete all errors. This feature only displays if there are errors in the file and is only available until
errors have been corrected and the file is saved.

o This will retain the totals and counts for audit history.

Discard the file. This feature shows up when there is an error in the file. This option is not available
after corrections have been made and saved.

remove the file and its contents from the system.
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< Back to 5tatus

File Status

Queued Processed

@ Edit 4 Errors

ASBC1 Issue 0415-004.xlsx

Approved / Rejected

Errors occurred during loading. View list below to edit errors. If errors remain after 04/21/21

Rows 1-40of4,

Completed

. the Issuance file will be automatically discarded.

O Click any row to select that row for editing

Discard File

Deleted

Line
Number Account Serial Number Amount Payee Name’ Status Issuance Date
7 211 11568 $30.00 Richard Canova ISSUED 04/1572021
6 FAR RG] 11567 $260.00 Office Pride ISSUED 0471572021
5 11 11566 $600.00 Jonathan Copeland ISSUED 0471572021
Michael Copeland
4 2111 11565 $65.55 Cisco Webex, LLC ISSUED 0471572021

(=]

£l

=]

In this case, the account numbers in the issuance file were entered incorrectly and they need to be

corrected before the file can be fully processed and loaded.

h. Click on any of the fields highlighted in red to make updates or changes.

@ Edit 4 Errors
Rows 1-4 of 4.
Line
Number Account Serial Number Amount Payee Name’ Status
2111 11568 30 Richard Canova ISSUED
- select accoun v 11568 s 30 . . ISSUED
7/ | Richard Canova
- select account - y
OctaTest - xxxx8888
The One and Only - 001111 X i
6 PC Test - 001360 11567 $260.00 Office Pride ISSUED

Gilbert's Grapes - xxx6732

Issuance Date Delete
2021-04-15
B | 04/15/2021 —
— m
04/15/2021 o

In this example, the user is presented with an account number drop-down so they can choose the correct account

number for the issuance item.
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i. Once all errors have been corrected, the red highlights are no longer visible, and the file can be reprocessed
by clicking the Save and Submit button. This feature is only available until all errors are corrected, deleted,
or discarded.

® Edit 4 Errors
Rows 1-4of 4.
Line
Number Account Serial Number Amount Payee Name’ Status Issuance Date Delete
7 The One and Only 11568 $30.00 Richard Canova ISSUED 04/15/2021 [1]
- 0001111
[ 2+ H557F $266:00 SfficePride 554D S452824 d
5 The One and Only 11566 $600.00 Jonathan Copeland ISSUED 04/15/2021 i
-000¢1111 Michael Copeland
4 The One and Only 11365 $65.35 Cisco Webex, LLC ISSUED 04/15/2021 [i]
-oox1111
© Click any row to select that row for editing l
Discard File Save and Submit

j- The file will be returned to processing.

Saao St PGO1 Issue 0303-002.xlsx

File Status

Queued Processed Completed Deleted

File is processing ...

k. If the file processes successfully, the user will be able to view the details on all the items in the file.
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< Back to Status PGO1 Issue 0303-002.xIsx
File Status
Queusd Processed Approved Completed Deleted
File processing is complete, View list below to see itams.
@® View items: 15 Irems totaling $12.246.81 Load Date; 03/03/2021 15:07:38 EST
Rows 1-15of 15.
Actount Number Serial Number Amount Payee Name Status Issuance Date
003783 2665 §6555  Cisco Webex, LLC 03/03/2021
003783 2666 $600.00 Jjonathan Copeland NEW_ISSUANCE_ITEM 030312021
Michael Copeland
0ox3783 2667 $260.00 Office Pride NEW_ISSUANCE_ITEM 03/03/2021
003783 2668 §75.00  Richard Canova NEW_ISSUANCE_ITEM 03/03/2021
0ox3783 2669 §933.00  Waller Lansden Dortch & Davis, LLP NEW_ISSUANCE_ITEM 0310372021
w3783 2670 $24.00  Advanced Medica NEW_ISSUANCE_ITEM 0370372021
woox3783 2671 $6,120.00 Citizens Union Bank NEW_ISSUANCE_ITEM 0210372021
wox3TE3 2672 §53.38 Covey Seminars NEW_ISSUANCE_ITEM 030372021
wox37E3 2673 519393 Cuyahoga County Clerk NEW_ISSUANCE_ITEM 03/03/2021
wox3TE3 2674 §2.800.00 Michael Farrel NEW_ISSUANCE_ITEM 03/03/2021
003783 2675 $150.00 MNesta Archeron NEW_ISSUANCE_ITEM 03/03/2021
Elain Archeron
w0373 2676 515000  Jake Chambers NEW_ISSUANCE_ITEM 03032021
wox3TE3 2677 $750.00 ABC Carpentry NEW_ISSUANCE_ITEM 03/03/2021
wox3TE3 2678 $35.00 Office Pride N SSUANCE_ITEM 031032021
003783 2679 $26.97 FedEx NEW_ISSUANCE_ITEM 030372021
Delete

If there are no errors in the file during the initial load, then the file will automatically display as approved
and complete.

If an issuance file needs to be deleted for any reason, the user can click on the Delete button and the file will
be removed. Deleting a file will retain item counts and totals as audit history.
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. Date Range
Issuance Files Status — gn .
m=February 28, 2020~
Y Filters ?
.84
Issuance Load File Load ) . Transaction Transaction
ID ID File Name Status Status Message Date/Timeli Count Total View/Manage
4123 2418 CSVIssue DELETED Deleted By Client 02/28/2020 14:23:52 8 $6,354.64 View
0228 3.csv User EST

NOTE: Files are only eligible for deletion if every item in the file is still in an available for matching status. If just
one item in the file has been paid, the file cannot be deleted.

2. Multiple Payees:

Positive Pay has the ability to support customers with multiple payee names on issued items. The system can
score multiple names on a check against information provided in the issuance file.

a. When the user loads issue files into the system, the loaded file is processed with the Issue Template set up
within Positive Pay. The Issue Template allows for selection of a Multi-Line Payee Separator, a character
chosen to separate the names of multiple payees in the issue file.

b. When the user loads issue files into the system, the loaded file is processed with the Issue Template set up
within Positive Pay. The Issue Template allows for selection of a Multi-Line Payee Separator, a character
chosen to separate the names of multiple payees in the issue file.

If multiple payees are listed on two or more separate lines on a check, the multiple payee separator
character (which should match the one designated in the template), must be used between each name. In
the example below, the Multi-Line Payee Name Separator designated in the Issue Template is a pipe (|). The
issue items shown are entered with the pipe separator between each name, with no spaces.

1 2! 3 4 5 6 7 8 9| 10 N 12 13 14 15 16 17)
1 Type Num Date Name ltem Account Paid Amount Original Amount
—

2 {
3

r
4 Bill Pmt -Check 9384 06/07/2020 Jonathan Copeland|Michael Copeland 1111111111 $65.55

r Nesta Archeron|Elain Archeron|Micah |
5 Bill Pmt -Check 9385 06/07/2020 Archeron 1111111111 $600.00

When the issue file is loaded, the system would then separate the data before and after the character as
separate payees.

33



Positive Pay
User Guide

TN

Please refer to Subsection D of this Section, Issue Templates, for more information about Multi-Line Payee
Name Separators and how best to utilize this feature.

3. Issuance Dual Approval:

Some clients may have the optional Issuance Dual Approval feature enabled. In this circumstance, loaded issue
files must be approved by a second user or, if no second user is available to approve the file, the customer can
request the Bank to approve the issue file.

Please refer to Subsection H. Issuance Dual Approval for more information about the Dual Approval process.

G. Issue File Status

The purpose of the Issue File Status feature is to provide users the ability to view and/or manage issue files loaded or

manually entered by the client. The disposition or status of the file is available. Authorized client users can also manage
these files as outlined in the next section.

1. View Issue File Status

a. Within the Positive Pay module, click View > Issue File Status.

Positive Pay £ Manage ~ < Perform = o1 Reports ~ i= View «

Issue File Status
Issue Warehouse

We I C( Transaction History

Item Lookup .
Please use th 1 action

b. The Issuance Files Status page appears.
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. Date Range
[ssuance Files Status =
=uly 15, 2020 - July 21, 2020~
¥ Filters >
10 files totaling $121,719.10
Rows 1-10of 10.

Issuance Load ID File Name Status Load Date/Timeli Transaction Count Transaction Total View/Manage
> 5873 AcmeZ Issue 0721-001 xlsx SYSTEM_APPROVED 07/21/2020 08:55:38 EDT 15 $12,171.81 Manage
> 5872 Acme1 Issue 0721-001 xlsx SYSTEM_APPROVED 07/21/2020 08:54:57 EDT 15 $12,171.81 Manage
» 58350 Acme2 Issue 0720-001.xIsx SYSTEM_APPROVED 07/20/2020 09:23:31 EDT 15 $12.171.81 Manage
> 5848 Acme1 Issue 0720-001.xIsx SYSTEM_APPROVED 07/20/2020 09:23:11 EDT 15 $12171.81 Manage
> 5833 Acme2 Issue 0717-001 xlsx SYSTEM_APPROVED 07/17/2020 09:39:38 EDT 15 $12171.81 Manage
> 5832 Acme1 Issue 0717-001.xlsx SYSTEM_APPROVED 07/17/2020 09:38:54 EDT 15 £12171.81 Manage

c. Tofilter the date range of files shown, click on the Date Range drop-down.

Date Range

Issuance Files Status =
=uly 15, 2020 - July 21, 2020~

Y Filters Tomorrow
10 files totaling $121,719.10 Today
Rows 1-100f 10, Yesterday
Issuance LoadID  File Name Status Load Date/Timeli Transaction Count  Transacti [RESTAEH
» 5873 Acme2 Issue 0721-001xlsx ~ SYSTEM_APPROVED  07/21/2020 08:55:38 EDT 15 s ThisMonth
Last Month
» 5872 Acme1 Issue 0721-001xlsx ~ SYSTEM_APPROVED  07/21/2020 08:54:57 EDT 15 s
Custom Range
> 5850 Acme2 Issue 0720-001xlsx  SYSTEM_APPROVED  07/20/2020 09:23:31 EDT 15 s Cancel

d. To narrow the search results, click Filters and a window containing additional search criteria will appear.

. Date Range
Issuance Files Status - g
=EMay 1, 2020 - May 31, 2020~

Y Filters v
Issuance Load ID Status Min Amount
- select status - v E
Max Amount

s naxi
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Issuance Load

The ID number associated with the specific file.

ID
Status

Client_Approved

Client_Discarded

Client_Rejected

Deleted

Edit_Pending

Failed
FI_Approved

Fl_Rejected

Ineligible_Items

The file was approved by the Customer.

Client discarded means a client user decided to discard
the issue file before it was fully processed into the
database.

If Issuance Dual Approval is configured for a client,
client rejected means a client user rejected the issue file
during the dual approval process.

A deleted file has been processed into the system but
was removed by Bank or Customer user. The file
information will still be in the system and can be found
in the Issue warehouse.

A file in this status was loaded with errors. Before the
file can be processed into the database and be
displayed in the issue warehouse or be used in
matching, the errors will need to be cleaned up or
removed from the file.

The file failed to load.

The file was approved by the Bank.

If Issuance Dual Approval is configured for a client, Fl
rejected means a Bank user rejected the issue file
during the dual approval process.

The file contains ineligible items, and the load did not
complete successfully. Ineligible items will need to be
removed and the file reloaded.

Loading The file is loading.

Processing The file is processing.

Queued The file is in line awaiting a status change.
Suspended The file has been suspended.

“Suspended” status can be related to the Issuance
Dual Approval feature. Please refer to Subsection H.
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Min Amount

Max Amount

System_Approved

System_Discarded

Test_Approved

TN

Issuance Dual Approval, for more information about

this feature.

The system is set to default approve the file.

Discarded files are files that a user loaded to Positive
Pay and had errors that need to be cleaned up. If the

errors are not cleaned up by deadline displayed under

the progress bar, which is three days, the file will be

automatically discarded by the system and no record of

it will be kept.
In test mode a client user is able to load issue files to

make sure that the issue template that was created and

the file loaded to the system correctly. This function
informs the user if the file will process in the regular

user interface, but items are not available for matching

in test mode.

The minimum dollar amount of the entire file.

The maximum dollar amount of the entire file.

e. Once search criteria are selected, click Apply to narrow your search results.

f. Search results are displayed in pages of 25 items. If the search contains more than 25 issue files, the results
will be displayed on multiple pages. Use the navigation buttons at the top of the search results to review all

results.

20 il 1 <1
28 files totaling $2

00
00
un
un
w

2L
-

Rows 1 - 25 of 28.
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Issuance Load
ID File Name

Issuance Load ID the ID number assigned by Positive Pay when a file is loaded. Their value only comes into play if the Bank
needs to contact ACH Alert regarding an issuance file loading problem, they cannot troubleshoot themselves. These pieces
of information should be provided in any helpdesk ticket opened.

File Name The file name assigned by the Customer at load time. If the transactions were manually entered the file name
will appear with a prefix of MANUAL followed by a system generated number sequence for ease of differentiation.

Load
- z
Status Date/Timel:
Status Please see #4 in this section for a list of possible Status codes.
Load Date/Time The date and time this file was loaded.
Transaction Transaction
Count Total View/Manage
Transaction Count The number of transactions contained within the file.
Transaction Total The total dollar amount of the transaction.
View Displays View button if a file has no errors or is ineligible to be edited. It is

important to note that authorized Bank users can click View to get to the
Delete button to delete a file. See below for more information.
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Manage Displays Manage button if the file contains errors that can be edited. See
below for more information.

2. Click the arrow (>) next to the Client Code to view more useful detail on each issuance file.

w4832 Issue 0528-001.xlsx FAILED 05/29/2020 09:59:29 View
EDT
File Id: Status Message: Unable to parse file. Error reading record #2
w4829 MANUAL_ 1590702542494 SYSTEM_APPROVED  05/28/2020 17:4%:02 6 $3.,099.60 Manage
EDT
File Id: 2854
File ID The ID number assigned by Positive Pay once an issuance file is processed and

committed to the database. If an Issuance Load ID is present but a File ID is
not, the file was received but did not load properly or has not been processed
all the way to the database. The File ID is useful when contacting ACH Alert
Help Desk about a problem with a file.

Status Message Displays error messages, approval or rejection data, or indicates if an issue file
has been deleted.

Click View button to view the individual issue files. The [File Name] page appears.
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< Back to Status

File Status

Queued

File processing is complete, View list below to see items,
File cannot be deleted because it has items already used in matching

@® View items: 15 Items totaling $12,246.81 Load Date: 03/02/2021 11:36:23 EST
Rows 1-150f 15
Account Number Serial Number Amount Payee Name Status Issuance Date
001111 13788 $65.55 Cisco Webex, LLC USED_IN_MATCHING 03/02/2021
00001 13789 $600.00  Jonathan Copeland USED_IN_MATCHING 03/02/2021
Michael Copeland
00l 13790 $260.00 Office Pride USED_IN_MATCHING 03/02/2021
00001 13791 575.00  Richard Canova USED_IN_MATCHING 03/02/2021
oo 13792 $933.00 Waller Lansden Dortch & Davis, LLP USED_IN_MATCHING 03/02/2021
ool 13793 524.00 Advanced Medical USED_IN_MATCHING 03/02/2021
00l 13794 $6,130.00 Citizens Union Bank USED_IN_MATCHING 03/02/2021

WEKP1 Issue 0302-002.xIsx

Processed Approved Completed Deleted

File Status Bar

Load Date
Account Number
Serial Number
Amount

Payee Name

Status

Displays progress of issue file. This feature automatically refreshes and keeps the user
informed on the status of the file as it goes from Queued to Approved or Failed.
The date and time loaded of each item within the file.

The Account Number of each item within the file.

The serial number of each item within the file.

The dollar amount of each item within the file.

If Applicable, the name of the payee of each item within the file.

Available for Matching Items marked as Available for Matching are issue items
that have loaded to the system but have not been
matched to a presented item.

Used in Matching Items marked as Used in Matching are issue items that a
presented item has been matched to.

New Issuance Item This status will only display in a file that was not loaded to
the database for processing.

Ineligible for Items ineligible for modification are items that have been

Modification matched to presented items and are either in a current
status of paid or returned and can therefore no longer be
modified.
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Duplicate Issuance Duplicate issuance items are issue items that duplicate
previously loaded issue items exactly.

Issuance Date The date of the issued item.

3. Manage Issue File Status
a. Click Manage button to edit errors within an issue file. The [File Name] page appears.
i. Correct Items

1) Fields highlighted in red have an error and are blocking the issue file from loading all the way to
the system.

2) When a highlighted field is clicked the user can either select the correct data from a dropdown
or enter it in directly in the field.

3) Once all errors have been corrected, the user can click Save and Submit at the bottom, so the

file is reprocessed.

® Edit 9 Errors
Rows 1-90f 9,
Line
Number Account Serial Number Amount Payee Name’ Issuance Date Delete
5555555555 9255 65.55 Cisco Webex, LLC 2020-05-28

- select account - v 9255 $ | 6555 _ » ~ B | 05/28/2020 o

4 Cisco Webex, LLC m
FFFriends - 01111
FFF Payroll - 002222

5 FFF Expense - 003333 8256 $600.00 Jonathan Copeland 05/28/2020 i
FFF Escrow - xooadddd

ii. Delete items
1) Individual items can be deleted from the errors screen if the option is available.
2) The user would click the trashcan in the Delete column to delete any individual items.
3) Once items have been deleted, the user can click Save and Submit at the bottom, so the file is
reprocessed.
a) The user can also click Delete All Errors at the top of the delete column.
4) This will allow the rest of the file to process into the system.
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< Back to Status Issue 0529-001.xlsx
File Status

Queued Processing Processed Approved Complete Deleted
Errors occurred during loading. View list below to edit errors. If errors remain after 06/03/20, the issuance file will be automatically discarded.

@ Edit 9 Errors

Rows 1-90f9,
Line
Number Account Serial Number Amount Payee Name’ Issuance Date Delete
4 5555555555 9255 £65.55 Cisco Webex, LLC 05/28/2020 [}
5 5555555555 9256 £600.00 Jonathan Copeland 05/28/2020 i
6 5555555555 9257 $260.00 Office Pride 05/28/2020 ]

iii. Discard a File
1) An entire issue file can also be discarded.
a) The user can click the discard button at the bottom of the screen.
b) Another option is to allow the system to discard the file automatically after three (3)

business days.

In both instances, the system will act as if the file never existed and any issue information from the file will not appear in
any reporting or view.
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< Back to Status Issue 0529-001.xlsx
File Status
Queued Processing Processed Approved Complete Deleted
Errors occurred during loading. View list below to edit errors. If errors remain after 06/03/20, the issuance file will be automatically discarded.
® Edit 9 Errors
Rows 1-90f9.
Line
Number Account Serial Number Amount Payee Name’ Issuance Date Delete
4 5555555555 9255 $65.55 Cisco Webex, LLC 05/28/2020 i
L 5555555555 9256 $600.00 Jonathan Copeland 05/28/2020 i
3 5555555555 9257 §260.00 Office Pride 05/28/2020 m
7 5555555555 9258 o Richard Canova 05/28/2020 i
8 5555555555 9259 §933.00 Waller Lansden Dortch & Davis, 05/28/2020 i
LLP
9 5555555555 9260 0 Richard Canova 05/28/2020 i
10 5555555555 9261 £53.36 Richard Canova 05/28/2020 i
11 5555555555 9262 $24.00 Advanced Medical, Inc. 05/28/2020 @
12 5555555555 9263 $6,130.00 Citizens Union Bank (v) 05/28/2020 @
@ Click any row to select that row for editing
Discard File

iv. Delete a File

1) Users are also able to delete an issue file if none of the items in the file have been used in
matching by clicking on the delete button.
a) When afile is deleted the items will appear in issue views and reporting.
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< Back to Status PGO1 Issue 0303-002.xIsx
File Status
Queued Processed Approved Completed Deleted
File processing is complete. View list N 10 See items.
@ View items: 15 Items totaling $12,246.81 Load Dare: 03/03/2021 15:07:38 EST
Rows 1-150f 15
Account Number Serial Number Amount Payee Name Status Issuance Date
003783 2665 $65.55  Cisco Webex, LLC AVAILABLE_FOR_MATCHING 03/0372021
003783 2666 $600.00  Jonathan Copeland AVAILABLE_FOR_MATCHING 03/0372021
Michael Copeland
0003783 2667 $260.00  Office Pride AVAILABLE_FOR_MATCHING 03/03/2021
003783 2668 §75.00 Richard Canova AVAILABLE_FOR_MATCHING 03/0372021
0003783 2669 $933.00  Waller Lansden Dortch & Davis, LLP AVAILABLE_FOR_MATCHING 03/03/2021
0003783 2670 52400  Advanced Medical AVAILABLE_FOR_MATCHING 03/0372021
003783 261 $6,130,00  Citizens Union Bank AVAILABLE_FOR_MATCHING 03/0372021
0003783 2672 55236  CowveySeminars AVAILABLE_FOR_MATCHING 03/03/2021
0003783 2673 $19393  Cuyahoga County Clerk AVAILABLE_FOR_MATCHING 03/03/2021
003783 2674 $2,800.00 Michael Farrell AVAILAELE_FOR_MATCHING 030372021
woo3783 2675 $150.00 Nesta Archeron AVAILAELE_FOR_MATCHING 03/0372021
Elain Archeron
0003783 2676 $15000  jake Chambers AVAILABLE_FOR_MATCHING 030372021
0o3783 2677 £750.00 ABC Carpentry AVAILABLE_FOR_MATCHING 03/03/2021
003783 2678 $3500  Office Pride AVAILABLE_FOR_MATCHING 03/0372021
003783 2679 526.97 FedEx AVAILABLE_FOR_MATCHING 03/03/2021
Delete

4. Issuance Dual Approval:

Some clients may have the optional Issuance Dual Approval feature enabled. In this circumstance, manual issue
entry files or loaded issue files must be approved by a second client user or, if no second user is available to
approve the file, the client can request the Bank to approve the issue file.

Please refer to Subsection H. Issuance Dual Approval for more information about the Dual Approval process.
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H. Issuance Dual Approval

Positive Pay offers the ability to support dual approval for issuance file loads. If enabled, any manual issue entry
files or issue files loaded by the Customer will be held in “suspended” status until approved or rejected by a
secondary user.

1. If a User has manually entered issue items or loaded an issue file requiring dual approval, another user must
approve the issue file or manual entry file. A message will be sent via email or SMS to users with the Approve
Issue File user privilege to alert them of files pending approval.

2. Within the Positive Pay module, click View > Issue File Status.

Positive Pay £+ Manage ~ # Perform ~ o1 Reports = iE View ~

Issue File Status
Issue Warehouse

We | C( Transaction History

Item Lookup .
Please use th n action

3. The Issuance Files Status page appears. Files requiring dual approval will show a status of “Suspended”. Click the
Manage button to review the file.

. Date Range
Issuance Files Status g

&March 3, 2021~

Y Filters >

" z
Issuance Load ID File Name Status Load Date/Timeli Transaction Count Transaction Total View/Manage
> 8838 PGO1 Issue 0303-002.xlsx SUSPENDED 03/03/2021 15:07:37 EST 15 51224850, Manage

4. The Issue File review page displays a File Status box at the top of the screen which outlines the current status of
the file. The status bar will be highlighting “Approved/Rejected,” and will note if the file is pending approval.
Approve and Reject buttons display in the File Status box.
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< Back to Status

File Status

Queued

Processed

PGO1 Issue 0303-002.xIsx

Approved / Rejected

File is pending approval. View list below to approve items.

Completed

Reject

5. Alist of each issue item contained in the file will display below the File Status box. Their status will display as
“New Issuance Item.” The client user can review the entries to determine if the file should be approved or
rejected. In addition, the client user can delete the file prior to and after approval by clicking the Delete button

at the bottom of the screen.

$12.

Account Number

003783

003783

WO3TE3

003783

0003783

w0ox3783

0003783

W0oe3783

w00x3783

W0oET83

003783

W0O3T83

w3783

W0O3783

WO0ETES

Approve items: 15 Items totaling
2,246.81

Serial Number

2665

2666

2667

2668

2669

2670

2671

2672

2673

2674

Amount

$65.55

$933.00

§24.00

$6,130.00

$53.36

$193.93

$2.800.00

$150.00

$150.00

$750.00

$35.00

£26.97

Rows 1-150f 15.
Payee Name

Cisco Webex, LLC

Jonathan Copeland
Michael Copeland

Office Pride

Richard Canova

Waller Lansden Dortch & Davis, LLP
Advanced Medical

Citizens Union Bank

Covey Seminars

Cuyahoga County Clerk

Michael Farrell

Nesta Archeron
Elain Archeron

Jake Chambers
ABC Carpentry
Office Pride

FedEx

Load Date: 03/03/2021 15:07:38
EST

Status

NEW_ISSUANCE_ITEM

NEW_ISSUANCE_[TEM

NEW_ISSUANCE_ITEM

NEW_ISSUANCE_ITEM

NEW,_ISSUANCE_[TEM

NEW_ISSUANCE_ITEM

NEW_ISSUANCE_ITEM

NEW_ISSUANCE_ITEM

NEW_ISSUANCE_ITEM

NEW_ISSUANCE_ITEM

NEW_ISSUANCE_ITEM

NEW_ISSUANCE_[TEM

NEW_ISSUANCE_ITEM

NEW_ISSUANCE_ITEM

NEW_ISSUANCE_[TEM

Issuance Date

03/03/2021

03/03/2021

03/0372021

03/03/2021

03/03/2021

03/03/2021

03/03/2021

03/03/2021

03/03/2021

03/03/2021

03/03/2021

03/03/2021

03/03/2021

03/03/2021

03/03/2021

Delete
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6. If the file is to be approved, click the Approve Button. Once the file is approved, the file status displays that the
file processing is complete.

< Back to Status

File Status

Queued

Processed

File processing is complete. View list below to see items.

PGO1 Issue 0303-002.xIsx

Approved

Completed

Deleted

a. After the approval is complete, the issue items will display the status “Available for Matching.” The Delete
button will still be available to delete a file after approval.

Account Number

w00x3783

20003783

w3783

wox3783

w03783

20003783

woxx3783

w3783

003783

20003783

w00x3783

w00x3783

Serial Number

2665

2666

2667

2668

2669

2670

2676

2677

2678

2679

® View items: 15 Items totaling $12,246.81

Amount

$65.55

$600.00

Rows 1-150f 15.

Payee Name

Cisco Webex, LLC

Jonathan Copeland
Michael Copeland

Office Pride

Richard Canova

Waller Lansden Dortch & Davis, LLP
Advanced Medical

Citizens Union Bank

Covey Seminars

Cuyahoga County Clerk

Michael Farrell

Nesta Archeron
Elain Archeron

Jake Chambers
ABC Carpentry
Office Pride

FedEx

Load Date: 03/03/2021 15:07:38 EST

Status

AVAILABLE_FOR_MATCHING

AVAILABLE_FOR_MATCHING

AVAILAELE_FOR_MATCHING

AVAILABLE_FOR_MATCHING

AVAILABLE_FOR_MATCHING

AVAILABLE_FOR_MATCHING

AVAILABLE_FOR_MATCHING

AVAILABLE_FOR_MATCHING

AVAILABLE_FOR_MATCHING

AVAILABLE_FOR_MATCHING

AVAILABLE_FOR_MATCHING

AVAILABLE_FOR_MATCHING

AVAILABLE_FOR_MATCHING

AVAILABLE_FOR_MATCHING

AVAILABLE_FOR_MATCHING

Issuance Date

03/03/2021

03/03/2021

03/03/2021

03/03/2021

03/03/2021

03/03/2021

03/03/2021

03/03/2021

03/03/2021

03/03/2021

03/03/2021

03/03/2021

03/03/2021

03/03/2021

03/03/2021

Delete

b. Returning to the Issuance Files Status page, the file will now display a status of “Client Approved.”
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Issuance Files Status

Y Filters

Load Date/Timeli

Issuance Load ID File Name Status Transaction Count
> 8851 MANUAL_1614805777127 CLIENT_APPROVED 03/03/2021 16:09:37 EST 1
> 8838 PGO1 Issue 0303-002.xlsx CLIENT_APPROVED 03/03/2021 15:07:37 EST 15

Date Range
EMarch 3,2021 -

?

Transaction Total View/Manage

$525.00 Manage

$12.2
$12,246.81 Manage

7. If thefile is to be rejected, click the Reject Button.

a. Once the file is rejected, the file status displays that the file has been rejected by [client username]. The

individual issue items will no longer display in the issuance file status.

< Back to Status WKP1 Issue 1207-003.xlsx

File Status

Queued Processed Rejected Completed

File has been rejected by FFFTomjones.

Deleted

8. Returning to the Issuance File Status page, the file will now display a status of “Client Rejected.”

. Date Range
Issuance Files Status — .
E=December 1, 2020 - March 3, 2021 ~
Y Filters >
1 files totaling $12,171.81
Rows1-10
Issuance Load ID File Name Status Load Date/Timeli Transaction Count Transaction Total View/Manage
> T4 WHKP1 Issue 1207-003.xlsx CLIENT_REJECTED 12/07/2020 17:19:47 EST 15 $1217.81 View
NOTE:

e Ifanissuance file is currently in “Suspended” status, the file is not released at EOD; but rather, will

remain in this status indefinitely until approved or rejected.

48



Positive Pay
User Guide

e If anissuance file is currently in “Suspended” status, and the client level setting for Issuance Dual

i

Approval is disabled, or user privileges are removed before the affected issuance files are approved or

rejected, the file will remain in the Suspended status but cannot be managed by the user. In this
circumstance, Bank user can still approve or reject the file to move it out of the Suspended status.

l. Issue Warehouse

Positive Pay provides the Bank and Customer with the visibility to see the status of all issued items. Authorized users
can modify items in the Issue Warehouse. Customers can use the Issue Warehouse to search for issued items for a
Client or specific account using one of the many filtering options available.

1. Within the Positive Pay module, click View > Issue Warehouse.

Positive Pay £ Manage ~ # Perform =

o1 Reports ~

Welci

i= View ~

Issue File Status

Issue Warehouse

Transaction History

Item Lookup

Please use th n action
2. The Issue Warehouse page appears.
Date Range
Issue Warehouse _
=mMarch 3, 2021~
Y Filters >
31
Account Serial Issue Load . . Issuance
ItemID Number Number Payee Name Type Match Status Amount Date/Timeli Date Update
> 2286366 0003783 100945 Moe Green ISSUED  OUTSTANDING  $525.00 03/03/2021 16:09:37  03/03/2021 s
EST
> 2386349 0003783 2679 FedEx ISSUED  OUTSTANDING $26.97 03/03/2021 15:07:38  03/03/2021 v
EST
> 2286348 00m3783 2678 Office Pride ISSUED  OUTSTANDING $35.00 03/03/2021 15:07:38  032/03/2021 s
EST
> 2386347 0003783 2677 ABC Carpentry ISSUED  OUTSTANDING  $750.00 03/03/2021 15:07:38  03/03/2021 v
EST
> 2386346 0003783 2676 Jake Chambers ISSUED  OUTSTANDING  $150.00 03/03/2021 15:07:38  03/03/2021 P

EST

3. To filter the date range of items shown, click on the Date Range drop-down.
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Y Filters
31 transactions totaling $25.018.62
Rows 1 - 25 of 31.
Account Serial Issue
ItemID Number Number Payee Name Type Match Status
> 2386366 003783 100945 Moe Green ISSUED QUTSTANDING

Load

Amount Date/Timeli

Date Range
EMarch 3, 2021~

Tomorrow
Today
Yesterday
Last 7 Days
This Month
Last Month

Custom Range

$525.00 03/03/2021 16:09: Cance!
EST

4. To narrow the search results, click Filters and a window containing additional search criteria will appear.

Date Range
Issue Warehouse _ 9
EMarch 3, 2021~
Y Filters v
Account’ Serial Number Date Range Filter Type
=gt selectrd - ¥ O Issue Date ® Load Date
Min Amount Serial Number Range
$ — Min Serial Num Max Serial Num Issue Type
Max Amount - select issue type - v
s X ount Match Status
- select match status type - hd
Account Type an account name or the last 4 digits of the account number.
Serial Number Type the item serial number for a specific issued item.
Date Range Issue Date: If selected, issue items will be filtered by the issue date rather than the
Filter Type load date.
Load Date: If selected, issue items will be filtered by the load date rather than the
issue date.
Min Amount The minimum dollar amount.
Max Amount The maximum dollar amount.
Serial Number Min Serial Type the minimum serial number in the range
Range Num

i
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Max Serial
Num
Issue Type Issued

Voided
Stopped

Match Status Paid

Returned

Outstanding

NOTE:

i

Type the maximum serial number in the range.

The check has been issued for payment.
The check has been voided by maker.
The check has a stop payment placed on it.

There was a presented item for the issued item, and it has
been paid.

There was a presented item for the issued item, and it has
been returned.

There has been no presented item for the issued item, it
remains outstanding for 180 days as a default unless
specified otherwise by your financial institution.

e Issuance data is available for 1 year as the default setting, but this can be configured differently by the

Bank.

e If Additional Issue Fields are being used, a section to filter by that data will display.

5. Once search criteria are selected, click Apply to narrow your search results.

6. Search results are displayed in pages of 25 items. If the search contains more than 25 issue items, the results will
be displayed on multiple pages. Use the navigation buttons at the top of the search results to review all results.

79 transactions totaling $61,748.44

Rows 1 - 25 of 79.

Item ID

Account Serial
Number Number
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The ID number associated with the specific file once an issuance file is processed and
Item ID .
committed to the database.
Account Number Displays the Account Number for the item.
Serial Number Displays the issued item serial number.
Issue
Payee Name Type Match Status

Payee Name Displays the name of the payee for the item.
Issue Type Issued The check has been issued for payment.

Voided The check has been voided by maker.

Stopped The check has a stop payment placed on it.
Match Status Paid There was a presented item for the issued item, and it has been paid.

Returned There was a presented item for the issued item, and it has been

returned.
Outstanding There has been no presented item for the issued item, it remains
outstanding.
Load ) 2 Issuance
Amount Date/Timel: Date Update

Amount Displays the dollar amount for the issued item.
Load Date/Time Date and time the item was loaded.
Issuance Date The date of the issued item.
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Update Click the pencil icon to update item’s Amount, Status, or Issuance Date.

7. Click the arrow (>) next to the Client Code to view more useful detail on each issued item. The information
shown in this drop-down is an audit history of all the activity that has occurred on the issue item.

ItemID  Account Number  Serial Number Payee Name Issue Type  Match Status  Amount Load Date/Timel: Issuance Date  Update
¥ 3389966 oox1111 12304 FedEx ISSUED PAID £180.00 09/02/2021 10:44:38 EDT 09/02/2021 ®
Status Amount Issue Date Updated By Updated Date/Time
ISSUED $180.00 09/02/2021 sdelaerel 09/02/2021 10:44:38 EDT
Status Issued The check has been issued for payment.
Voided The check has been voided by maker.
Stopped The check has a stop payment placed on it.
Amount Displays the dollar amount for the issued item.
Issue Date The date of the issued item.
Updated By The user who updated the issue item.
Updated Date/Time The date and time this issued item was updated.

8. Modifying Issue ltems.
a. Issue items can be modified by users with a Load Issue File or Manual Issue Entry privilege. Issue items can
only be modified if the match status = outstanding. Click the edit pencil button under the Update column to
update the issued item.

Account Serial Issue Load . Issuance
ItemID  Number Number Payee Name Type MatchStatus  Amount  Date/Timeli Date Update
> 2276362 wox1111 9263 Citizens Union Bank (v) ISSUED OUTSTANDING $6,130.00 05/29/2020 10:04:33  05/28/2020 ya
EDT :

9. The Update Issue Item pop-up window appears.
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Serial Number

9263

Save

Update Issue Item

Amount

6130

Payee Name’ Status Issuance Date

Citizens Union Bank (v) ISSUED v = 05/29/2020

Serial Number

Amount

Payee Name

Status

Issuance Date

10. Click Save.

Check serial number. This cannot be updated on an existing issued item.

Amount of the issued item. The amount can be updated.

The name of the Payee associated with the specific issued item. The payee name
can be updated.

Issued The check has been issued.
Voided The check has been voided by the maker.
Stopped The check has a stop payment by the maker.

It is important to note that if the Fl has disabled stop

payments in their configuration, Stopped may not be an

option in the drop-down menu on this pop-up screen.
The date of the issued item. The issuance date can be updated.

Issue updated.

11. A copy of the Issue Warehouse can be downloaded by clicking the Download As CSV button at the bottom of the
Issue Warehouse screen.
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J. Item Lookup

Positive Pay provides Customers with the ability to look up all recorded data on individual issued items with the
ltem Lookup feature.

1. Within the Positive Pay module, click View > Item Lookup.

Positive Pay & Manage ~ # Perform ~ o1 Reports « EView «

Issue File Status
Issue Warehouse

We I C( Transaction History

Item Looku
Please use th P ‘

2. The Item Lookup page appears. All fields are mandatory.

Irem Lookup

Account’ Serial Number

- not selected - v

Account - Select the Account drop-down to display a list of the Customer’s Accounts.
Serial Number - Enter the serial number of the item.

3. Once search criteria are selected, click Apply to complete the item lookup.

4. Search results for the item will be displayed. Within this screen, the lifecycle of the issued item will be displayed.
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Item Lookup
Account’ Serial Number
The One and Only - 0001111 (ASBank Client 1 - ASBC1) v 11548
Account Number: x01111 Serial Number: 11548 View Check Image
Transaction Date: 04-15-2021 Original Serial Number: 11548 Exception Reason: Amount Mismatch
Payment Date: 04-15-2021 Original Amount: $27.00 Payee Match Score: Error analyzing payee name
Transaction ID: 45566 Issuance Payee Name: FedEx Disposition Created: 04/15/2021 15:00:00 EDT
Debit Amount: $27.00 Issuance Serial Number: 11548
Current Status: Pay-System Issuance Amount: $180.00
Issuance Status: ISSUED
Transaction Date: 04-15-2021 Original Serial Number: 11548 Exception Reason: Duplicate Presentment
Payment Date: 04-15-2021 Original Amount: £127.00 Payee Match Score: Error analyzing payee name
Transaction ID: 45567 Issuance Payee Name: FedEx Disposition Created: 04/15/2021 15:00:00 EDT
Debit Amount: $127.00 Issuance Serial Number: 11548
Current Status: Pay-System Issuance Amount: $180.00
Issuance Status: ISSUED
Issuance Date: 04/15/2021 Update By: mfleetwood1 Payee Name: FedEx
Updated Date/Time: 04/15/2021 13:34:17 EDT Transaction Id: 45566 Match Status: PAID
Load Date/Time: 04/15/2021 13:34:17 EDT Issue Type: ISSUED Amount: $180.00

K. Other Options Prior to Item Presentment

If a Customer needs to make changes to an item prior to item presentment, there are three options for doing so
within Positive Pay. Examples of changes that would fall under this category would be when items originally
issued are updated to Voided or Stopped status, or to overwrite existing item information such as changes in
amount and/or payee.

It is important to note that if the Fl has disabled stop payments, it will affect whether a client user can perform
these functions in some instances. Please see Subsection B. Status Values within this Section for more
information.

56



Positive Pay
User Guide

i

1. Modifying Issue Items

Issue items can be modified in the Issue Warehouse. Please refer to previous Subsection H. Issue
Warehouse, for more information.

2. Manual Re-Entry

To change individual items previously submitted, a Client user can overwrite the previous item as follows:
a. Within the Positive Pay Module, click Perform > Manual Issue Entry.

Positive Pay £ Manage ~ # Perform ~ o Reports ~ View «

Issue File Load
Manual Issue Entry

Transaction Approval CO m e

Please use the above menu to select an action

b. The Manual Issuance File Entry page appears. For definitions of the fields available on this screen, please
refer to Subsection C of the current Section.

Manual Issue Entry

Account’ Auto populate next check number:
- not selected - hd
Row Serial Number Amount Payee Name’ Status Issuance Date
ISSUED v 05/29/2020

© Click any row to select that row for editing

Save

c. Create a Manual Entry for the item to be changed. The serial number must match the previously submitted
item. Fill out all fields, updating the fields that need to be overwritten with the correct information.

d. When all pertinent manual issuance files have been re-entered, click Save button.
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e. The Manual Issuance File detail page appears. For definitions of the fields shown on this screen, please refer
to Subsection C of the current Section.

3. File Reloads

To change multiple items that were previously submitted, a Client can use the Issue File Load function to reload
and overwrite previous items in an Issue File.

a. Once you have prepared your Issue File with all items that need to be overwritten, including the corrected
information in the appropriate fields, upload the Issue File. Refer to Subsection F. Loading Issue Files, for
more information.

4. Prior to item presentment, these changed/overwritten items can be seen in the Issue Warehouse (please refer
to Subsection | within this Section for information on how to access the Issue Warehouse). Once within the
Issue Warehouse screen, click the arrow (>) next to the Client Code to view more useful detail on each issued
item. The information shown in this drop-down is an audit history of all the activity that has occurred on the
issue item.

As you can see in the figure below, there are three issue items that have been updated/changed. The
updates/changes from the most recent entries will overwrite the previously loaded issue item.
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Date Range
Issue Warehouse
Eiuly 21, 2020~
Y Filters >
30 transactions totaling $24,443.62
Rows 1 - 25 of 30.
Account Serial Issue Load . Issuance
ItemID Number Number Payee Name Type Match Status Amount Date/Timel: Date Update
v 2278881 0003210 3494 FedEx VOIDED  OUTSTANDING $26.97 07/21/2020 08:55:38  07/21/2020 ya
EDT x
Status Payee Amount Issue Date Updated By Updated Date/Time
VOIDED FedEx $26.97 07/21/2020 SallyAcme1 07/21/2020 13:08:19 EDT
ISSUED FedEx $26.97 07/21/2020 SallyAcme 07/21/2020 08:55:38 EDT
> 2278BB0 003210 3493 Office Pride ISSUED QUTSTANDING $35.00 07/21/2020 08:55:38  07/21/2020 V3
EDT
W 2278879 oo3210 3492 ABC Carpentry ISSUED QOUTSTANDING $850.00 07/21/202008:55:38 07/21/2020 ya
EDT i
Status Payee Amount Issue Date Updated By Updated Date/Time
ISSUED ABC Carpentry $850.00 07/21/2020 SallyAcrmet 07/21/2020 13:09:50 EDT
ISSUED ABC Carpentry $750.00 07/21/2020 Sallyacmet 07/21/2020 08:55:38 EDT
v 2278878 oo3210 3491 Jake Chambers STOPPED OUTSTANDING $150.00 07/21/2020 08:55:38  07/21/2020 ya
EDT .
Status Payee Amount Issue Date Updated By Updated Date/Time
STOPPED Jake Chambers $150.00 07/21/2020 SallyAcmet 07/21/2020 13:08:44 EDT
1SSUED Jake Chambers $150.00 07/21/2020 SallyAcmet 07/21/2020 08:55:38 EDT

L. Other Options After Item Presentment

1. Pay & Issue

Single Pay & Issue is an Enterprise feature which allows a client to allow the system to create an issue item they failed to
send in. This is used for balancing.

2. Mass Pay & Issue

This feature provides a way to handle system creation of multiple issue items instead of the user having to click Pay &
Issue for each individual issue item if the Client failed to send an entire file and it resulted in a lot of no issue exceptions.
In addition, it provides a mass pay decision, instead of addressing them one at a time.
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Please refer to Section VI, Managing Check Presentment, for more information

Exception Identification

Positive Pay is configured to identify exceptions on issue items in a specific order. Once the first exception is triggered on
an issue item, the system does not evaluate the item further. If an item is flagged with an exception and is deferred to
the user for decision, it must be noted that further analysis will not be performed. Users should be conscious when
paying an exception that other validations may not have been performed, so they should examine the item.

Listed below are the possible Exceptions and the order in which they are flagged by Positive Pay. It is important to note
that the Exception Code and Reason below can be customized by financial institution so the example below may vary
slightly from exception codes or reasons that appear in the Client interface.

Exception
Order

1

10

Exception Code

Issuance not found
Issuance already used

Issuance voided

Issuance stopped

Issuance amount mismatch

Amount over limit

Issuance date in future

Issuance stale dated

Issuance payee mismatch

Exception reason missing

Reason

Check presented where no issue item is found to match against.

Check presented with a serial number previously presented.

Check presented with a serial number of an issue item marked with a
void status.

Check presented with a serial number of an issue item marked with a
stop status.

Check presented where amount of check differs from issue amount.

Transaction amount is over the limit.

Check presented with a date that is before the issuance date on the
issued item.

Check presented with a date that exceeds the specified number of
stale days for the account.

Check presented where payee name differs from issue payee name.

This message will only appear to customers of FI’s that are in Fl or
Hybrid Matching mode. This exception reason is only used if the
reason that is coming into Positive Pay has not been mapped in
Positive Pay.
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Managing Check Presentment

The primary objective of Positive Pay is to give users the opportunity to make pay and/or return decisions on checks
presented for payment on accounts enrolled for the service. The decision function is performed in the Transaction
History screen.

A. Transaction History

NOTE:
e Transactions are stored for 12 months.
e The Transaction History user privilege must be enabled to access this screen.
o If the user has been granted the Change Status user privilege and the transaction is available to decision,
the Pay and Return buttons will be available for use.
e Transactions that will be paid will have green shading as a background.
e Transactions that will be returned will have yellow shading as a background.
e Transaction status cannot be changed after the EOD cut-off time.

Positive Pay provides a function for Customers to search and view the status of checks presented on enrolled accounts,
and to make decisions on presented items. Users can use Transaction History to search for presented check items for a
specific account using one of the many filtering options available. It is important to note that the default filter setting is
Exceptions Only. Additional transactions may be available to view and decision (such as reverse positive pay items);
however, this will not be displayed unless the Exception filters option is set to Show All Transactions.

1. View Transaction History

Within the Positive Pay module, click View > Transaction History. The Transaction History page will display all
current day transactions for all accounts to which the user has access.

Date Range

Eseptember 2, 2021 -

Transaction History

Mass Pay & Issue

Y Filters >

z
Transaction ID Account Number Serial Number Credit Debit Current Status Dateli Change Status Exception

> 49194 0xx1111 12334 $127.00 Pay-System 09-02-2021 ® Return (2]
> 49193 oxx1111 @ $27.00 Pay-System 09-02-2021 ® Return (2]

> 49192 001111 12333 $35.10  Pay-System 09-02-2021 @ Return 1]
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Current Status

Date

Change Status

Exception
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Unique ID assigned by the Positive Pay system when transactions are loaded.

Account number the check was presented against.
The check number presented for payment.

Clicking on the serial number will display the front and back images of the
check. If an eye icon appears in the serial number column, this denotes an item
that was processed with no serial number. Clicking on the eye icon will display
the check image, if available.

This column will display if deposit information has been entered into the
system.

This column displays checks.

Pay Pay-System The system is set to default pay this
check.
Pay-Fl The check was paid by the FI.
Pay-User The check was paid by the Client User.
Return Return- The system is set to default return this
System check.
Return-Fl The check was returned by the FI.
Return-User The check was returned by the Client
User.

Date the check was presented for payment or loaded to Positive Pay.

If the user has been granted the Change Status user privilege and the
transaction is eligible for a decision, a Pay or Return button will appear for use.
If the transaction is not eligible for a decision, the button will display as
ineligible.

If the transaction is an exception, an exception identifier will appear in this
column.

a. Tofilter the date range of items shown, click on the Date Range drop-down.
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Y Filters
Transaction ID Account Number Serial Number
> 49194 X0xx1111 12334

debit transactions t g $34,896.60

Rows 1 - 25 of 45.

Credit Debit Current Status

$127.00 Pay-System

Datel:

09-02-2021

Date Range
ESeptember 2, 2021 ~

Tomorrow
Yesterday

Last 7 Days
This Month
Last Month

Custom Range
Change =

53 -

b. To narrow the search results, click Filters and a window containing additional search criteria will appear.

i

. . Date Range
Transaction History - ¢
=March 4, 2021 -
¥ Filters v
Account’ Serial Number Items
- not selected - b Any Items hd
Min Amount Serial Number Range Transaction Status
5 . Min Serial Num Max Serial Num Pay -
Pay-System
Max Amount Pay-Fl
R . Pay-User
s 2 Exceptions Retu;n
Show All Transactions w Return-System
O Default
Pending Approval
Show All w
Account Type an account name or the last 4 digits of the account number into the field to
view transactions for one specific account or select an account from the drop-down
menu.
Min Type the minimum check amount into the field.
Amount
Max Type the maximum check amount into the field.
Amount
Serial Type the check serial number for a single transaction. A serial number range can
Number also be defined by entering the minimum and maximum serial number.
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The user may select from the drop-down to filter by one of the following:

» Exceptions Only
> No Exceptions

The default will be set to “Show All Transactions”; however, the user can click the
“Default” checkbox to select a different option to be the default for future filtering.

If the Bank has enabled Decision Dual Approval, this field may be available in the
filter window. The user may select from the drop-down to filter transactions based
on whether or not they are pending approval.

» Yes — will display only transactions that are pending approval.
» No — will display only transactions that are not pending approval

The default will be set to “Show All”.

For more information regarding Decision Dual Approval, please see Section VII,
Decision Dual Approval.

Defaults to Any Items. Select the drop-down to select one of the following:

» Any Items: This includes all items, including client pay and adjust items.
» Adjusted Items: Checks that were paid by a client user and either the amount and/or
serial number was adjusted.

Pay

Return

Pay-
System

Pay-Fl

Pay-
User

Return-
System

Return-
FI
Return-
User

The system is set to default pay this
check. If a user takes no action before
EOD, the check will pay.

The check was paid by the FI.

A user changed the transaction status
from a Return to a Pay status.

The system is set to default return this
check. If the user takes no action
before EOD, the check will be
returned.

The check was returned by the FI.

A user changed the transaction status
from a Pay to a Return status.

c. Once search criteria are selected, click Apply to narrow your search results.
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d. Search results are displayed in pages of 25 items. If the search contains more than 25 issue items, the results
will be displayed on multiple pages. Use the navigation buttons at the top of the search results to review all
results.

45 debit transactions totaling $34,896.60

Rows 1 - 25 of 45.

-2

e. Summary Debit and/or Credit transaction totals are also displayed at the top of the screen above the
navigation buttons.

3,859 debit transactions totaling $16,010,788.39

150 credit transactions totaling $194,496.50

Rows 1 - 25 of 4,009.

f. Click the arrow (>) next to the Client Code to view more useful detail on each issued item. The information
shown in this drop-down is an audit history of all the activity that has occurred on the issue item.
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. . Date Range
Transaction History

Mass Pay & Issue

Y Filters >

i,aﬂuary 1, 2021 - September 2, 2021~

Current Status Datel:

Transaction ID Account Number Serial Number Credit  Debit Change Status Exception
v 49194 ooc1 111 12334 $127.00  Pay-System e ¢
Positive Pay Type: standard Payment Date: 09-02-2021 Adjust

Issuance Serial Number: 12334 Loaded Exception Reason: Duplicate Presentment Teller ID: FedEx
Issuance Amount: $180.00

Issuance Date: 09-02-2021

Original Serial Number: 12334

Original Amount: §127.00
v 49193 0001111 12334 $27.00 Pay-System 09-02-2021 m o
Adjust
Teller ID: FedEx

Positive Pay Type: standard Payment Date: 09-02-2021

Issuance Serial Number: 12334 Loaded Exception Reason: Amount Mismatch
Issuance Amount: $180.00

Issuance Date: 09-02-2021

Original Serial Number: 12334

Original Amount: $27.00

¥ 49192 001111 12333 $3510 Return-User 09-02-2021

i °

Positive Pay Type: standard
Issuance Serial Number: 12333

Issuance Amount: $750.00

Return Date: 09/02/2021 16:00:00 EDT
Return Reason: Amount Incorrect

Loaded Exception Reason: Amount Mismatch

Teller ID: ABC Carpentry

Issuance Date: 09-02-2021
Original Serial Number: 12333

Original Amount: $35.10

Positive Payee Type This indicates the type of positive pay that the account is set for:

Standard, Reverse and Payee are the different types that could display here.

Issuance Payee Name Name of payee submitted with the transaction presented for payment.

Issuance Serial Number Serial number on the issued item uploaded by the customer.
Issuance Amount Amount on the issued item uploaded by the customer.
Issuance Date Date the issued item uploaded by the customer.

Original Serial Number Serial number submitted with the transaction presented for payment.
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Payee Match Score
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Amount submitted with the transaction presented for payment. This number may be
different than what is displayed in the top line. For instance, if an item was adjusted in
pre-scrub by the Bank or if the Bank is allowing Customers to adjust.

Date the item was returned.
Date listed within the transaction file.
Reason for return.

This user documentation displays the standard exception reason labels; however, each
Bank can customize these during implementation so what is seen in the documentation
may differ from what the User may see in the service if their Bank has customized the
labels.

Please refer to Section V. Exception Identification to view a list of all standard
exception labels.

Payee scoring is addressed in the account configuration screen. The score displayed
here is the score that was assigned by the payee analysis engine when the payee name
on the check was compared to the payee name provided on the issue item.

2. Change Transaction Status

a. If the user has been granted the Change Status user privilege and the transaction is eligible for a decision, a
Pay or Return button will appear for use. If the transaction is not eligible for a decision, the button will
display as ineligible.

3. Change Status — Pay

a. If the Current Status on an issued item is set to Return, the Client can opt to change the status to Pay if the
Client determines the check should be paid.

b. Click the Pay button under the Change Status column.

> 14484 0ox1111

Transaction ID Account Number

4
Serial Number Credit  Debit Current Status Dateli Change Status Exception

8580 $6,130.00 Return-User 03-18-2020 m

The Change Status button will then change to Return, and the Current Status column will update to “Pay-User.”

4. Change Status — Return
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a. If the Current Status on an issued item is set to Pay, the Client can opt to change the status to Return if the
Client determines the check should not be paid.

b. Click the Return button under the Change Status column.

> 14463 0001111 8579 $2400 Pay-System 03-18-2020 m

c. Check Return Reason pop-up window appears. Select the appropriate reason for the Check Return. Please
note that the list of return reasons displayed are the system default but may vary depending on the way the
financial institution defines them.

Select a check return reason:

Amount Incorrect
Duplicate
Fraudulent

Prior Stopped
Prior Void

Refer to Maker
Serial # Incorrect
Signature Irregular

Signature Missing

Stale Dated

Save
Amount Incorrect The dollar amount is incorrect.
Duplicate This item has already been presented.
Fraudulent Fraudulent item.
Prior Stopped This item has a stop payment placed on it.
Prior Void The item has been previously voided.
Refer to Maker Refer to the maker of the check.
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Serial # Incorrect The serial number on the item is incorrect.

Signature Irregular The signature does not match.

Signature Missing The item is missing a signature.

Stale Date The presented item has a date greater than the number of stale days allowed on the

corresponding issued item.

Suspect Item — The item is suspicious and possibly fraud — please review further.
Review Required

d. Click Save

Check will be returned

e. The Change Status button will then change to Pay, and the Current Status column will update to Return-
User.”

5. A copy of the Transaction History can be downloaded by clicking the Download As CSV button at the bottom of
the Transaction History screen.

B. Optional Accounts

1. Confirm Paying Exceptions (May or may not be implemented by the Bank)

a. When the first exception is triggered on a presented item, additional validations are not performed. If the
system detects a user pay decision on a check that additional validations were not performed (such as payee
name analysis which is the last validation to occur), an image of the check will be presented to allow the
user to visually inspect the check. The user must click the confirm button to finalize the pay decision.

b. If the user decides to pay an item that is set to return, they will be presented with a pop-up window to

confirm that this is the action they wish to take. The window will display an image of the check and other
details for the user to review before confirming that they want to pay the item.
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Confirm Check

ravroris ACH Alert, LLC. | $ 42037 |
Four-hundred twenty and 37/100

pOLLARs () EX=

vivo 9300 of gold, less interest Scrooge McDuck
+1a 322276774 15 139999999999 15 152

Exception Reason: Check presented where amount of check differs from issue amount

Issuance Serial Number: 152 Issuance Amount: $75.75

Check amount and serial number may be adjusted after Confirm

1) A pop-up window with check information will display for the user’s review.

2) Once the user has reviewed the information presented, they can decide to Confirm so that the

check will be paid or to Cancel so that the check will be returned.

2. Pay & Issue

a.

This feature must be enabled by the financial institution and the user must have the manual issue entry,
load issue file and change transaction status user privileges. If an exception is triggered because no issue
item exists and the user pays the check, the user will be presented with a link allowing them to tell the

system to create a matching issue item.

If Client Pay & Issue is enabled, the expanded view on the item will display an Add Issue button. Click the

button to proceed.

TN
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v 20537 oo 111 9718 $36.10  Pay-System 07-21-2020 (1]

Positive Pay Type: Payee Payment Date: 07-20-2020

Add Issue
Original Serial Number: 9718 Exception Reason: No Issue Item

Original Amount: $36.10

i. Add Issue Item pop-up displays. The Serial Number, Amount, and Status are all locked from editing. Click
in the Payee Name to enter a payee name, or the Issuance Date field to select the date of the issued

item.
Add Issue Item:
Serial Number Amount Payee Name’ Status Issuance Date
9718 36.1 Office Pride] ISSUED B | 07/21/2020
4
Save
1) Click Save
Issue added.
NOTE:

e Items with duplicate presentment exceptions will not present the option to Add Issue from
within Transaction History, as another item has been presented and paid with that serial
number.

e |tisimportant to note the system will not allow the “Add Issue” function for a check with no
serial number.

e “Add Issue” will not be available for transactions in Reverse Positive Pay accounts.

3. Pay & Adjust
a. This feature must be enabled by the financial institution and the user must have the manual issue entry,
load issue file and change transaction status user privileges. The FI may choose to allow users to adjust a
serial number from the value presented to a new value and/or the amount from the amount presented to a
new value.

b. If Client Pay & Adjust is enabled, a link will display under the Pay button: “Adjust?”
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Transaction ID Account Number Serial Number Credit Debit Current Status

~ 17764 o1 111 9272 $6,230.00 Pay-System

Positive Pay Type: Payee Payment Date: 05-29-2020

Issuance Payee Name: Citizens Union Bank {v) Exception Reason: Amount Discrepancy
Issuance Serial Number: 9272

Issuance Amount: $6,130.00

Original Serial Number: 272

Original Amount: $6,230.00

Dateli

05-25-2020

Change Status Exception
.
Adjust
1 —

i. Click Adjust.

1) The Adjust pop-up screen displays. The fields available in Adjust are contingent upon what the Fl
has enabled. In this example, the Adjust screen includes check amount and serial number. Enter

the correct serial number and/or amount.

Adjust Check Amount and Serial Number:

Serial Number:

Amount:

Save

9272

6230

2) Click Save. The Transaction History page displays the adjusted serial number and/or adjusted

amount.

Transaction ID Account Number Serial Number Credit Debit Current Status

¥ 17764 00001111 9272 $6,135.00 Pay-User

Positive Pay Type: Payee Payment Date: 05-29-2020

Issuance Payee Name: Citizens Union Bank (v) Exception Reason: Amount Discrepancy
Issuance Serial Number: 9272
Issuance Amount: $6,130.00

Original Serial Number: §272

Original Amount: $6,230.00

Dateli

05-29-2020

Change Status

°

Adjust

Exception
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3) When the serial number is changed using Pay & Adjust, any issuance items previously matched
and used by this transaction will be marked as “Available for Matching”, releasing the issuance
for matching by future transactions. In addition, issuance matching will be performed using the
new serial number and if any issuance is found it will be marked as “Used in Matching.”

Decision Dual Approval

Positive Pay offers the ability to support dual approval for client decisioning. If enabled. any transactions in a return

status that are decisioned by the client will be held in “suspended” status until approved or rejected by a secondary
user.

If Decision Dual Approval is enabled, and a User has decisioned any transaction in the Transaction History to the status
of User-Pay or has adjusted the serial number or amount of any transaction, approval will be requested to approve the
change of the transaction status. The secondary client user must approve the transaction decision.

1. Within the Positive Pay module, click Perform > Transaction Approval.

Positive Pay £* Manage ~ # Perform ~ W Reports ~ = View ~

Issue File Load
Manual Issue Entry

TransactionApprovaI«)I ne

Please use the above menu to select an action

2. The Check Transaction Approval screen will display.

Check Transaction Approval

Select

[all]

none ] Account Current Serial Requested Serial Current Requested Current Req UESEEd
Number Number Number Amount Amount Date Status Statusli Exception
> ] 2003579 1327 $20.00 03-04- Return- Pay (]
2021 User
> [m] 0003579 [ $200.00 03-04- Return- Pay 2]
2021 User

Selected

73



Positive Pay
User Guide

Select [all | none]

Account Number

Current Serial
Number

Requested Serial
Number

Current Amount
Requested
Amount

Date

Current Status

Requested Status

Exception
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The client user can opt to select individual transactions by clicking the
checkbox at the left of the row. The client can also select all transactions
by clicking “all” in the Select column. The client can de-select all
transactions by clicking “none”.

Displays the masked account number for the item.

The current serial number of the item. The client user can click the
hyperlink in the serial number to view an image of the check. An eye icon
denotes an item that has no serial number.

The updated serial number, if changed by the client user performing the
decisioning.

Original amount of the transaction.

The updated amount, if changed by the client user performing the
decisioning.

Date of the transaction.

Current status of the transaction.

The status of the transaction, if approved.

If the transaction is an exception, an exception identifier will appear in
this column.

3. Clicking the arrow (>) at the far left of each row will expand the view for more pertinent information about the

transaction.

Select
[all ]

Account Current Serial

none ) Requested Serial Current Requested Current REq ueszted
Number Number Number Amount Amount Date Status Statusli Exception
v 003579 1327 $20.00 03-04- Return- Pay (1]
2021 User

Transaction ID: 31223
Requested By: CBBoots3

Loaded Exception Reason: No Issue Item

Transaction ID

Requested By

Loaded
Reason

loaded

Exception The exception identified when the transaction was loaded.

Unique ID assigned by the Positive Pay system when transactions are

The client user who has requested the change of transaction status.
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4. After examining the transactions pending approval, the client user can select items to approve or reject by
clicking the Approve or Deny buttons at the bottom of the screen.

5. If atransaction is Approved, a Confirm Approval pop-up window will appear. The user can click the Confirm
button to confirm the approval of the transaction status change or click the Cancel button to return to the Check
Transaction Approval Screen.

Confirm Approval

Approve status change of 1 check

Click Cancel to return or Confirm to continue

6. If atransaction is Rejected, a Confirm Rejection pop-up window will appear. The user can click the Confirm
button to confirm the rejection of the transaction status change or click the Cancel button to return to the Check
Transaction Approval Screen.

Confirm Rejection

Reject status change of 1 check

Click Cancel to return or Confirm to continue

7. Updating Transactions in Pending-Pay Status:

In the case of No Issue transactions that are in Pending-Pay status awaiting approval or rejection, the user may
do the following:

a. AddIssue: A transaction currently in Pending-Pay status can be updated in the Transaction History page by
expanding the view on the transaction and clicking the Add Issue button.

Before changes, the transaction will appear without payee information as shown below.
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Select
I
rE:neI] Account Current Serial Requested Serial Current Requested Current Req ueSItEd
Number Number Number Amount Amount Date Status Statusli Exception
v O oo 111 11605 554,00 04-19- Return- Pay o
2021 User

Transaction ID: 45615
Requested By: mfleetwood1

Loaded Exception Reason: Mo Issue Item

i. InTransaction History, click the Add Issue button.

v 45615 x00c1111 11605 $5400 Pending-Pay 04-19-2021 o

Positive Pay Type: payee Return Date: 04/19/2021 15:00:00 EDT Add Issue
Original Serial Number: 11605 Return Reason: Amount Incorrect Teller 1D: Covey Seminars
Original Amount: $54.00 Loaded Exception Reason: No Issue Item

ii. Complete the Add Issue pop-up screen by entering a Payee Name and clicking the Save button.

Add Issue Item:

Serial Number Amount Payee Name’ Status Issuance Date

11605 54 Henry Fordham ISSUED = 04/16/2021

P

* Account Configured for Recon: To select a date other than today, X out and add issuance after the Pay request is approved

Save

iii. The changes will be reflected in the Transaction Approval screen, as shown below.

Select
ranr|1|e|] Account Current Serial Requested Serial Current Requested Current Req ues}ed
Number Number Number Amount Amount Date Status Statusl. Exception
v O 2001111 11605 5£54.00 04-19- Return- Pay o
2021 User
Transaction ID: 45615 Issugnce Requested
Requested By: mfleetwood1 Requested Issuance Amount: $54.00
Loaded Exception Reason: Mo Issue Item Requested Issuance Date: 04-16-2021

Requested Issuance Status: ISSUED

b. Items currently in Pending-Pay status will not allow the user to adjust the serial number or amount.
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It is important to note that if a transaction decision is currently awaiting approval from a secondary client user and the
transaction is not approved or rejected by EOD, the transaction will revert to its original status. For instance, if a
transaction is set to default return and a user decision the item to be paid, if that decision is not approved by EOD, the
item will revert to the default return status.

Reports

Reports are available for one (1) year.

A. Issue Item Status Report

1. Within the Positive Pay Module, click Reports > Issue Item Status.

Positive Pay ¥ Manage ~ # Perform ~ i Reports - = View ~

Issue Item Status ‘

Welcome

Please use the above menu to select an action

2. The Issue Item Status Report page appears. The page will default to Outstanding items but can be changed to
Paid items or Returned items.

Issue Item Status

Issue Item Status

Issuance Status Start Date End Date
2 | Clickto Set = | 10/28/2020
@ Outstanding
O Paid
N Summary Information Only Account’
O Returned
O Stops/Voids -not selected - v

Issuance Status Outstanding Any items that have not been matched and decisioned yet.

Paid Any items that have been matched and paid.
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Start Date
End Date

Summary
Information Only

Account

3. Once search criteria are selected, click Apply to narrow your search results.

Returned

Stops/Voids

Any items that have been matched and returned.

Any items that have a stopped/voided status.

The start date is only applicable when filtering by Paid or Returned Issuance Status.

The end date will default to the current date.

Will show summary, rather than detailed, information on the displayed data.

To further narrow down the results the report can be filtered by a specific account.

4. Search results are displayed in pages of 25 items. If the search contains more than 25 transactions, the results

will be displayed on multiple pages. Use the navigation buttons at the top of the search results to review all

results.

5. The Issue Item Status report will populate below the search window.

Account Number

o111

o111

o111

o111

o111

o111

o111

o111

Serial Number

9263

9262

Payee Name

Citizens Union Bank (v}

Advanced Medical, Inc.

Richard Canova

Waller Lansden Dortch & Davis, LLP

Richard Canova

Office Pride

Jonathan Copeland

Cisco Webex, LLC

Amount

$6,130.00

$24.00

$53.36

£933.00

£1.00

£260.00

£600.00

$65.55

Issuance Date

05/28/2020

05/28/2020

05/28/2020

05/28/2020

05/28/2020

05/28/2020

05/28/2020

05/28/2020
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Account Displays the masked account number.
Number

Serial Number Displays the serial number for the item.
Payee Name Displays the payee name, if applicable.
Amount Displays the amount of the issuance item.
Issuance Date Displays the date of the issuance item.
Payment Date Displays the payment date of the item.
Return Date Displays the return date of the item.

6. If the Summary Information Only checkbox was selected, the Issue Item Status report will populate with
summary information as shown in the graphic below.

Account Number Account Name Check Status Total Items Total Dollar Amount

w1111 WEP Main Qurstanding Issued Items 281 £267,978.96
WHNM222D WHP Payroll Qurstanding Issued Items 17 $9,311.83
0003333 WEP Expense Outstanding Issued Items 3 $1,464.75

Grand Total: $278,755.64

Account Displays the masked account number.

Number

Account Name Displays the name of the account.

Check Status Displays the status of the issued items.

Total Items Displays the total amount of items with a particular check status

for a specific account.

Total Dollar Displays the total dollar amount of all items in the row.

Amount

Grand Total Displays the grand total dollar amount of all items displayed in the
rows above.

7. The entire Issue Item Status Report can be downloaded as a CSV file (Comma Separated Value). Click on the
Download as CSV button at the bottom left of the Issue Item Status Report screen.
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Payee Positive Pay Tips and Best Practices

For client users to have the best user experience possible, we have outlined some best practices to help make the
onboarding process more efficient.

A. Payee Name Comparison: “Scoring”

Positive Pay payee name scoring is robust and can reasonably handle a variety of check styles, fonts, and even
hand-written names on a payee line with fewer exceptions than most systems in the market. However, if your
organization would like to achieve optimal scoring results for payee positive pay, we recommend you follow as
many of the best practices outlined in the sections below.

Payee name scoring relies upon the customer using the best possible check design and format. However, when
customers do not follow best practices and there are problems with analyzing the check images for payee
information, the Fl does have options to allow for alternative actions, such as scrubbing exceptions and payee
override after visually inspecting the check.

Ideal Check Formatting
Customers will find the most success following these suggestions in their check designs and format.

e Paper weight should be 24” MICRBond (to ensure better image quality when physically captured
with reader).

e Use check stock with no backgrounds or lighter colored backgrounds and no logos or marks in the
payee field.

e  Minimum 200 dpi resolution required; higher resolution preferred.

e Checks should be fixed width (fixed spacing) 10-point font or higher.

e Sans Serif fonts are preferred (no bold).

e “PAY TO THE ORDER OF” should not be italicized or underlined and must be printed horizontally at
the same level to the left of the payee name.

e Payee name should be a maximum of 500 characters and left aligned.

e The payee name should be surrounded by an area of white space.

e Payee name should not be underlined.

Below are examples of checks that have been formatted to ensure best results:
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Sample Company
1 Main Street 1001

Cityyille, Z& 00000 Date 06/26/2020
S Office Max SL__305.98]

Three hundred five and 98100 Dollars

Memo Office Supplies Charles R. Huffington
L2 3LSEPBG SB87ESL® 00

? Client XYZ My Bank No. 1012

| 123 First Street 123 Bank Road Sn.0689

| Louisville, KY 40212 r

‘ (502) 123 1234 Date 10/1172016
Pay To The

_ Order Of . ABC Baby Store R : 0 R ) 849700, 00

| Two Hundred and 00/100 B8 Bl 5/ 5 WY E ROk B N e __ Dollars

Pre-approved Check - No Signature Required

Memo: For pu:cha;w order #1234

®*00000:0 e 1L 23L56789101L23LSE789"

YOUR COMPANY NAME HERE
123 MAN STREET
YOUR TOWN, STATE AND 2P

*00 300 4 wOOOOE7BSL: L23LSE78N
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C. Common Check Formatting Problems

Following are some examples of check formats which cause processing errors and issues with payee scoring.

Bad Scans & Poor Image Quality Poor image quality can interfere with scans.

It appears the check paper was inserted into the printer improperly, causing the payee name information to

print in a blurred/slanted.

L

| Qo
one

TN LA TE (O AMEA OF il Bov o ®

A

oAzg C¥0cnD

Seven Aundvd eighiy row and 78100 Datisry

AMERICAN
|y tx“;‘.'.iil_pr_\_._‘_‘—\—\_ ‘iw(.
Sy

POCKVULE, 140 2013

e

MET AW T
Huegr2n

W IR . ey '

WTRORES BT ,

*0000000000* 200 0000000« D0DDOODOOGO=

#DO0DD078 278

{

GHT TO VERIFY - PRINYED ON SECURITY PAPER & INCLUDES FLOURESCENT & VISIBLE FIBERS. BORDER CONTAINS MICROPRINTING,
’ . o Y

eck# 2005746

Chack Amount .
*k*$1,788,54 '

kperiod 04/26/2020

————— e US

d Signature
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Poor Image Quality

i

PAYROLL ACCOUNT \
| 06758 |  [3931.0000 | 10573 | 06/03/20| $920.34

Py Tren A=eur

Erach Ha. Cold Dag wvw ot 10 Marter Sl Sacurty Mambar Pay Date et Pay !
. E }
wssassssss s« s INE HUNDRED TWENTY DOLLARS & 34 CENTS*#ssassswaws

) ! )

Acme Commercial Bank

' PAY
To Tha
Ordur

Incorrect formatting and placement of check elements cause problems with analyzing check images for payee
information. This example shows several formatting/positioning errors that are not considered best practices:

ABC Company 1001
123 Main Street

o % Date: 02/01/2019
Cityville, ZA 00000 !

E—

E-S‘G*llllﬂf lgffldll’E'-ﬁl'l

*00000W0 L2 1X123LSE7891201L23L5E789

A - Background is too dark

B - San Serif Fonts are preferred. Labels here are in block, non-serif formats

C - “Pay to the Order of” should be printed level and to the left of the Payee Name line

D - Payee Name should not be underlined

E - Dollar Amount is positioned above the Payee section and using a script font which will cause issues in
scanning
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D. Multiple Payee Handling

Positive PAY has the ability to support customers with multiple payee names on issued items. Positive Pay can score

multiple names on a check against information provided in the issuance file. Multiple payees can be listed on a single
line, or on two separate lines on the check. Examples of correct and incorrect formatting are shown below.

ABC Company

123 Main Street 1001

Cityville, ZA 00000
Date: 03/01/2019

Pay to the .

or;’er of Elaine Archeron and Nesta Archeron $5300.29

Five Thousand Three Hundred and 29/100 Dollars

Memo: Consulting Services

Damuel Sranklin

*00000M0 k2™ K1 23L5678910423L56789

ABC Company
123 Main Street 1001
Cityville, ZA 00000

3 Date: 03/01/2019
Paytothe Elaine Archeron
order of Nesta Archeron $5300.29

Five Thousand Three Hundred and 29/100

Dollars

Memo: Consulting Services

é LA wr (\ﬁ{.ﬂ 1 !,ﬂr[-’l'aﬂ

"00000A0 k2 K L23L5E7B910L23L 56789
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ABC Company Check Number 3324

123 Main Street
. Pay Date 04/30/2020
~ Cityville, ZA 00000 Y ;
Amount |ONE THOUSAND THREE HUNDRED NINETEEN DOLLARS AND THIRTY-EIGHT CENTS | $1,319.28}

PAY TO THE ORDER OF Mark IV Properties ' }{A QL_

ABC Company
505 Roan Street
Mqinville, ZA 00000

3

*00000M0 L2 K 123L56789%0423L56789"

1. This section is designed to explain how to handle multiple payee names that will appear on two separate lines of
the check.

a. Multiple Payee Handling setup in Issue Templates.

i. The Multi-Line Payee Name Separator field is included in the Issue Template creation screen that allows
for recognition and recording of multiple payees on a check.

Create New Template

Template Name File Type’ Template Status
- select file type v Active v

Number of Header Rows’ Number of Footer rows’ Template Level’
0 0 Client v

Multi-Line Payee Name Separator: ’

Do not use a character as a separator if
that character will ever be presentina
Payee Name. Allowed characters in
brackets[; |.-_/]

ii. This feature allows the Bank or Customer to enter a character into the field that can be used to separate
Multiple Payee Names that are on separate lines of an issued item. Currently, the system restricts the
allowed characters to the following: ; | , - _ / . The user must be aware that using a separator
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character that appears elsewhere in the payee name or might conflict with the file itself can cause
issues. Examples of scenarios where problems might arise are listed below.

Within a Comma Separated file (.csv), different data fields are separated by a comma. Therefore, a
comma cannot be used in the data field itself, or the .csv will read the comma as a separator before the
next field. Therefore, listing two payees for an item in this way: “Elain Archeron,Nesta Archeron” will
cause issues reading the .csv file. In this scenario, the user should select a multi-line payee name
separator character that will not cause an issue, such as a semicolon. “Elain Archeron;Nesta Archeron”
in the Payee Name field of the .csv file will process correctly.

If the user selects a separator character that would ever appear in a payee name field, such as a dash (-),
the system will then separate the data before and after the character as separate payees. For instance, if
the user has selected a dash (-) as the Multi-Line Payee Name Separator, and a common payee used is
“In-and-Out Burger”, the system will flag this as having multiple payees. In this case, the user should
select a multi-line payee name separator that will not cause such issues, such as a pipe (|) or a
semicolon for cases of multiple payee names.

b. Multiple Payee Handling in Manual Issue Entry

i.  When the user performs Manual Issue Entry, the Payee Name field supports up to four Payees. When in
the Manual Issue Entry screen, the names should be listed as shown below. An Enter (carriage return)
must be used to input the second, third or fourth payee on separate lines in the field for it to be
distinguished as different payees.

Manual Issue Entry

Account’ Auto populate next check number:

clear

Row Serial Number Amount Payee Name’ Status Issuance Date

1710 26000.00 ISSUED v | @ | 06/30/2020

If the multiple payees are listed on a single line of the check, putting the names on separate lines is not applicable.
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Manual Issue Entry

Account’ Auto populate next check number:

clear

Row Serial Number Amount Payee Name’ Status Issuance Date

1710 26000 Nate Archeron and Nesta Archeron ISSUED v [ 06/30/2020

ii. Itisimportant to note that the Payee Name field currently supports 500 characters in total. This
character limit includes the carriage returns separating multiple payees. The 500-character limit is for
the entire field, and not per payee.

Please refer to Section IV, Subsection C, for more detailed information about Manual Issue Entry.
c. Multiple Payee Handling when Loading Issue Files.

i.  When the user loads issue files to the system, the loaded file is processed with an Issue Template set up
within Positive Pau. The Issue Template allows for selection of a Multi-Line Payee Separator, a character
chosen to separate the names of multiple payees in the issue file.

ii. If multiple payees are listed on a single line of a check, no action needs to be taken.

iii. If multiple payees are listed on two or more separate lines on a check, the multiple payee separator
character (which should match the one designated in the template), must be used between each name.

Please refer to Section IV, Subsection F, for more detailed information about Loading Issue Files.
d. Things to Remember: Multiple Payee Name Separators

To recap the information covered above, remember:

i. The Multi-Line Payee Name Separator character designated in the Issue Template must match what is
used in the Issue Files loaded to the system. The system will recognize that character and when
encountered in an Issue File, will record the data appearing after that character as a separate payee.

ii. The allowable charactersare: ; | , -

/.

iii. Some characters may cause problems when used as a separator. Do not use a character as a separator if
that character will ever be present in a Payee Name, or is a character used in a specific file type (i.e.,
Comma Separated files).
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of a check.

Preferences

A. Preferences

1. From within the Dashboard or Positive Pay Module, click User’s Name > Preferences.

t‘

-

o
,
i

Welcome 4
Logout

Please use the abave menu 1o select an action

2. The Preferences page appears.

Preferences
Default Pages

Default Module
- select -
Default PRO-CHEX Page

- default -

Default Dashboard Page

- default -

3. Default Module gives the User the ability to choose the default landing page.

Preferences

Default Pages

Default Madule

4. Default Positive Pay Page allows the user to select the default landing page within Positive Pay.
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Preferences

Default Pages

Default Module

PRO-CHEX ~

Default PRO-CHEX Page

- default - ~

Manage / Additional Issue Fields
Manage / Issue Templates
Perform / Issue File Load
Perform / Manual [ssue Entry
Reports / Issue Item Status

Reports / Scheduled
View / Issue File Status
View / Issue Warehouse
View / Item Lookup

View / Transaction History

5. Default Dashboard Page allows the user to select the default landing page within the Dashboard.

Preferences

Default Pages

Default Module

PRO-CHEX v
Default PRO-CHEX Page

- default - ~

Default Dashboard Page

- default - v

Manage Users
Reports / Audit Report
Reports / Notification Delivery Report

| Transaction view

6. Once any preferences have been selected, click Save to update the settings.

Preferences

Preferences Saved
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Appendix A — Message Alerts

Service Module | Alert Type Description Recipient
POSITIVE Pay CP Send Issuance Load Alert If Fl is sending issue files to ACH Alert on behalf | FI & Client
Failure of Clients, this alert is sent to users with the

system alerts flag enabled when an issue file
fails to load properly. If the Fl has enabled this
feature for Clients, this alert will be sent to
Clients with the issue load alerts privilege
enabled when an issue file loaded through the
Client portal has issues that prevent it from
loading successfully.

CP Send Issuance Load Alert If Fl is sending issue files to ACH Alert on behalf Fl & Client
Success Fl of Clients, this alert is sent to users with the
system alerts flag enabled when an issue file
loads properly. If the FI has enabled this feature
for Clients, this alert will be sent to Clients with
the issue load alerts privilege enabled when an
issue file loaded through the Client portal loads
successfully.

CP FI Cleanup Reminder Alert An alert per account sent to users when a file is Fl & Client
loaded after the cleanup deadline which
requires attention before EOD.

CP Acct All An alert per account sent to users for exceptions | Client
and any matched items.

CP Acct Exceptions An alert per account when one or more Client
exceptions exist that require a decision.

CP EOD Reminder This alert will be sent to Client users with the Client
change transaction status user privilege if
exceptions exist and a user with change
transaction status has not logged into the
system at the FI’s designated time. This alert
option will only be available if enabled by the
financial institution.

If alert method for PROCHEX is set to “None” for
a Client User, they will not receive the EOD
reminder alert.
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Service Module | Alert Type Description Recipient
CP TRX All An alert per check transaction. Client
CP Dual Decision Approval An alert sent to inform user that transactions Client
Reminder Alert involving dual decision approval are waiting to
be reviewed and approved or rejected.
CP TRX Exception An alert set per transaction deemed an Client
exception by the system.
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This guide is meant to aid users in exporting check file data from QuickBooks. There are two methods of exporting the

check file data from QuickBooks. Both options are outlined below. These examples are from the QuickBooks desktop

version. The first option is using a Quick Report from the checking account. The second method is using the Check Detail

Report, which requires more actions for the user to take.
A. Exporting from QuickBooks Account Register
1. From QuickBooks, use Ctrl+A to open the account listing from any screen

2. Click once to select the appropriate account to pull the Check File.

Castlerock Leasing, LLC. - QuickBooks Desktop Pra 2017 - [Chart of Accounts]

Edit View Lists Favorites Company Customers Vendors Employees Banking Reports Window Help Special Offers

- Pinnacle Bank
PEN - Millennium Bank
+ AcCounts Receivable
+ Loans Receivable
» Inventory Asset
+ Undeposited Funds
+ 202 Summitt Street
+ 102 Mcafee Road
+ 6543 Olde Landing Lane
+Land

My Shortcuts

Bank
Accounts Receivable
Otner CurrentAssel

Other Current Assel
Other CurrentAsset

FixedAsset
Fixed Asset
Fixed Asset
Fixed Asset

1483333

-322,118.58

0.00

0.00

0.00
46,297.06
-1.896.24
11419181
161,248.17

3. Once the Check Report has been populated, use Ctrl+Q to create a Quick Report from the selected account.

Customize Report Comment on Report Share Template Memorize Print * E.mail ¥ Excel « Hide Header Refresh

Dates Custom * From 05/04/2020 @& To|0?F151'2020 -.‘SortBy Default -

Show | Applied Filters

1:35 PM Castlerock Leasing, LLC.

07520 Account QuickReport

Accrual Basis As of July 15, 2020

Type Date Num Name Memo Split
Pinnacle Bank
» Payment 05/04/2020 3954 Accounts Re..

Bill Pmt -Check 05/04/2020 82 Accounts Pa...
Bill Pmt -Check 051042020 3183 Accounts Pa...
Bill Pmt -Check 0S/04/2020 3184 Accounts Pa
Check 05/04/2020 American Exp.
Check 05/05/2020 American Exp...
Check 05/06/2020 Online Trans... David - Draws
Check 051272020 Credit Cards
Payment 05/13/2020 3587 Accounts Re...

Amount

10,291.67
-500.00
-2,849.60
-207.62
-1.30
-1,000.00
-3,000.00
-35.00
10,251.67

Balance
22,084.84
3237651 4
31,876.51
23,026.91
28,819.29
28,817.99
27,817.99
24817.99
24,782.99
35,074.66
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a. Select the Date drop-down menu to choose a specific date or date range for the transactions to display in
the report. Based on the range that is selected, check items that can be displayed can be for a specific date,
a specific quarter, month or even a date range that the user selects.

Customize Report Comment on Report Share Template Memorize Print v E.mail ~ Excel « Hide Header Refresh
JsCICE- M This Fiscal Year ~ From 01/01/2020 B To 12/31/2020 B SortBy Default =
A

Show | This Week
This Week-to-date

119 PV —_— Castlerock Leasing, LLC.

oms Honth A t QuickR rt
This Month-to-date ccoun ulc ePo

Accrua As of December 31, 2020

This Fiscal Quarter
This Fiscal Quarter-to-date

= T nnacle Bank ol
Ll T Check 0110172020 -SPLIT- 1821225 607662 4

This Fiscal Year-to-Last Month

Type Date Num Name Memo Split Amount Balance

Check 0100272020 -SPLIT- -2,037.18 403944
This Fiscal Year-to-date Payment 01032020 3807 Accounts Re.. 1029167 1433111
Yesterday Bill Pt -Check 010372020 338 Accounts Pa.. -2,849.60 11,481.51
Last Week Bil Pmi -Check 010372020 3137 Accounts Pa.. -221.96 11,253.55
Last Week-to-date Bill Prt -Check 010032020 3138 Mowing201..  Accounts Pa.. 595,00 10,858.55
LastMonth Bill Prat ~Check 01032020 3139 December2..  Accounts Pa.. -365.00 10,293.55
Last Month-to-date Check 01/03/2020 American Exp... -19.44 10,274.11
Last Fiscal Quarter Check 01/06/2020 Onfne Trans...  David - Draws =3,000.00 7214 M
Last Fiscal Quarter-to-date Check 01/06/2020 American Exp... -1,000.00 62741

Payment 01/08/2020 0082... Accounts Re.. 1504167 21,1578
LastFiscal Year

Bill Prot -Check 01102020 3140 Accounts Pa.. -260.00 2105578
G EE TRl Check 0111372020 Credt Cards -35.00 2102078
DS esE v Check 01142020 Credt Cards £29 21,018.49
Neod 4 Weeks Check 01H1472020 Credit Cards 5487 20,949.62

b. Click Customize Report button. The Modify Report screen displays. By using the Customize Report feature,
the user will be able to manage the amount of information contained in the report prior to exporting the
report to Excel. The user can select and/or remove items that are not needed in the report.

Modify Report: Account QuickReport x

Display Filters Header/Footer  Fonts & Numbers

REPORT DATE RANGE

Dates ~  The date range you specify in the From and To fields

From 05/04/2020 B To 0711512020 W

REPORT BASIS

@ Accrual © Cagh This setting determines how this report calculates income and expenses.
COLUMNS
Search Columns Sortpy  Default -
s ® Ascendingorder 24
S A Sortin %
¥ (leftmargin) Descending order £
Trans # '
v e Advanced...
Entered/Last Modified

Put a check mark next to each column
v that you wantto appear in the report. Revert
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c. Click the Filters tab. In the listing of Filters, select Transaction Type. This will allow the user to remove the
transaction types that are needed for the check file.

Display Filters Header/Footer Fonts & Numbers
CHOOSE FILTER CURRENT FILTER CHOICES
Search Filters TransactionType FILTER ! SET TO
FILTER Account Pinnacle Bank
s Multiple Transaction Types -
Ship Via A Date Custom
VAl =
Template
Multiple Transaction Types
Terms
TransactionType
' Check
Vendor Type
v Deposit
Invoice Remove Selected Filter
TRAN SACTIONTYPE FILTER
Sales Receipt
Choose the type of transacti
select several transactionty, P ayment
Transaction Types.' Credit Memo
Journal
Credit Card
Bill Revert
CCard Credit
Bill Credit m Cancal Help
CCard Refund

d. From the Transaction Type drop-down menu, select Multiple Transaction Types. This will allow the user to
select multiple check types within QuickBooks. For this example, we have used Check and Bill Payment. Click
OK to confirm the transaction types.
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Display it Haadaroots

Select Transaction Types

CHOOSE FILTER

FILTER CHOICES

Search Filtere] list, then click OK. e
FILTER CCard Credit - Cancel Pinnacle Bank

Ship Via Bill Credit Custom

Template CCard Refund

Terms Bill Payment |'

TransactionTyf | Bill CCard

Vendor Type Sales Tax Payment

Remove Selected Filter

TRANSACTIONTYPE FILIER

Choose the type of transaction from the drop-down list. To
select several transaction types, choose 'Multiple
Transaction Types.’

Tell me more...
Revert

e. From the Modify Report screen, select OK to proceed. The requested changes to the report will display.

Customize Report Comment on Report Share Template Memorize Print * E-mail v Excel v Hide Header Refresh
Dates Custom * From 05/04/2020 B To [h7115!2020 [ | Sort By Default -

Show | Applied Filters

1:45 PM Castlerock Leasing, LLC.

0715120 Account QuickReport

Accrual Basis As of July 15, 2020

Type Date Num Name Memo Split Amount Balance
Pinnacle Bank -2,513,174.63
» Bil Pt -Check 05/0472020 3182 Connie Aien (v) Accounts Pa.. -500.00 -2,513,674.63 4

Bill Pmt -Check 050472020 3183 Debbie Peace Accounts Pa. -2,849.60 -2,518,524.23
Bill Pmt -Check 05/04r2020 384 Eastside Utility Dis... Accounts Pa... -207.62 -2,516,731.85
Check 05/0472020 American Express. American Exp... -1.30 -2,518,733.15
Check 05/0572020 American Express American Exp... -1,000.00 -2517,733.15
Check 05/0872020 Peace Transportat..  Online Trans...  David - Draws -3,000.00 -2,520,733.15
Check 05/12r2020 Citibusiness Platinum Credit Cards. -35.00 -2,520,768.15
Check 05/1372020 Citibusiness Platinum Credit Cards -45.0% -2,520,813.24
Check 05/1472020 American Express American Exp... -5,000.00 -2,525,813.24
Check 051472020 Costco Visa Credit Cards. -1,610.44 -2,527 42368
Check 0511472020 Citibusiness Platinum Credit Cards -25.00 -2,527 448,68
Bil Pt -Check 0511872020 3185 Donegal insurance... Accounts Pa.. 51591 -2,528,064.59

f.  From the QuickBooks toolbar, click the Excel drop-down menu and select Create New Worksheet.
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g. The Send Report to Excel pop-up window appears. Select Create New Worksheet > In New Worksheet and

click the Export button

to continue.

Customize Report Comment on Report Share Template Memorize Print |* E-mail * Excel ¥ Hide Header Refresh
Dates Custom ~ | From|05/05/2020 M| To 07/5/2020 W Sort By Default -
Show | Applied Filters
1:24 PM Castlerock Leasing, LLC.
07120120 Account QuickReport
Accrual Basis e
Send Report to Excel x
Type
Finnacie Bank WHAT WOULD YOU LIKE TO DO WITH THIS REPORT?
» Check 0}
Check o)
Check 0 @® in new workbook
Chack 9 @ in existing workbook
Check 0
Check q  Update an existing worksheet How it works
Check 0 ) Replace an existing worksheet
il P -Check 9 ) Create a comma separated values (.csv) file
Bill Prot ~Check 0
Bill Pmi -Check 0
Bill Pt ~Check o
Bill Pmé -Check 0
Bill Pmt ~Check 0f
Bill Pmt -Check of Advanced...
Check of
Check 0
d == =
Check TXPTEST =2z =T.oUTT!

h. Excel will open and the Excel file will populate. Within the Excel file, remove all rows that are blank under
the column header “Num”. By removing these items from the check file, items that do not have a serial
number assigned to them will not be uploaded into the Positive Pay System.

AutoSave (@ off) Book2 - Excel p Search -
File Home Insert Page Layout Formulas Data Review View Help Acrobat QuickBooks

fﬁ E& Calibri 1 VAN === Hv BWepTet Text - 1= @ @ xS

A~ .

Paste B I U-~ vl AL | =EE= =5 M PEnTS © . «0 00 | Conditional Formatas Cell Insert

~ - == - == E erge el $ % 9 Sl Formatting~ Table~ Styles~ v
Clipboard R Font ] Alignment ] Number (] Styles
Al * = K

A B c D E |F| G [H 1 [J] K L] M N (o] P Q
1 | ! Type Date Num Name Memo Split Amount
2 Pinnacle Bank |
3 gitemt Check  osnsz020 122 [N Accounts Payable -500.00

L "3
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Book2 - Excel
File Home Insert Page Layout Formulas Data Review View Help Acrobat QuickBooks
A Cut . AA === ® ab, Ny |
D 0 Calibri 11~ A == Y C& Wrap Text General - lorma
B Copy ~ .
Paste B I U-~ P - . . &0 .00 | Conditional Formatas |calculation
- d Format Painter - e - MesgeBtaey $ % ’ =L Formatting v Table v
Clipboard ] Font [ Alignment [ Number ]
016 7 F3
A B cD| E |F G |H I |J]| K |L| M N 0 P Q R S

1 Type Date Num Name i Memo Split Amount
2 Pinnacle Bank '

{ - |
3 Bill Pmt -Check 06/0172020 0001 Eastside Utilty District Accounts Payable -234.74

| r !
4 Check 06/15/2020 0002 Citibusiness Platinum Credit Cards -13.26

1 r
5 Check 06/1672020 0003 American Express American Express Business Gold -3,701.19

| b i
5] Check 06/16/2020 0004 Lowes Credit Cards -4,933.02

1 r 0
7 Check 07/01/2020 0005 PFinnacle Bank (v) | -SPLIT- -3,853.24

{ r |
8 Bil Pmt -Check 07/02/2020 0006 Eastside Utility District | Accounts Payable -143.18

1 r i
9 Check 0711472020 0007 Citibusiness Piatinum ! Credit Cards -1,416.38

1 | r H
10 Check 07/14/2020 0008 Lowes | Credit Cards -3,128.60
1 Total Pinnacie Bank | 42361
12 |ToTAL ‘
13

i. Select File > Save As and save the workbook.
a. Choose the File
b. Choose the Format. The file format for this file must be Comma Separated, Excel 97-2003
Workbook or Excel Workbook.

ﬂ Save As
< v 4 > ThisPC > Documents > New folder (2) v O D Search New folder (2)
Organize « MNew folder Bz - e
[ This PC MName Date modified Type Size
8 30 Objects B3:] Check File 0715202002.x1sx 7 5 PM Microsoft Excel W... 22KB
B Deskicp B3] CheckFileTestxlsx Microsoft Excel W, 12KB
Documents
‘ Downloads
b Music
= Pictures
B videos
- 0S(C)
== ACH Alert Share
¥ Network v
File name: | CheckFileQBTesting)xlsx
Save as type:  Excel Workbook (*xlsx) v
Authors: Tiffinay Famer Tags: Add atag Title: Add a title
[ Save Thumbnail
~ Hide Folders Tools Cancel
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j. Click Save and close the workbook.

4. From the Client Dashboard, a user can navigate to the Positive Pay Module by clicking Change Module > Positive
Pay

Dashboard ~ # perform »  JiReports » i Transaction View change Module

ACH Filter Debit
ACH Filter Credit Positive Pay
EDI TransAlert

End of Day Cut-Off Time: Friday 12:00 PM EST AGIEEnCret

5. From the Positive Pay module, select Manage > Issue Templates to create an issue template. This will allow the
user to map the exported information from QuickBooks so that the file is read correctly when uploaded to
Positive Pay. The user will also be able to save this template for use in future issuance file uploads.

Positive Pay £ Manage ~  # Perform ~ il Reports ~ = View ~
Issue Templates

Welcome

Please use the above menu to select an action

6. The Issuance File Templates page displays. This page lists the saved Issue File Templates available for the Client
to use and allows the user to create a new template for use. Select Create New Template.

Template File Type
Delete Filter by Template Filter by File Type Edit/View

2011 Regression C Comma Separated >
csv Comma Separated @
sVt Comma Separated @
DBFI Fixed Width Fixed Width >
Excel 1 Excel Workbook >
Excel 97-2003 Workbook Excel 97-2003 Workbook @
Quickbooks Type 1 Excel Workbook ®

m] 2008 Regression Comma Separated ’

m] 2008 Regression A Excel Workbook y
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7. The Create New Template screen appears.

Create New Template

Template Name File Type’ Template Status
- select file type v Active v

Number of Header Rows’ Number of Footer rows’ Template Level’
0 0 Client v

Multi-Line Payee Name Separator: ’

File Mapping
Add  InputField’ File Column’ Field Format
Serial Number

Amount? @ Fractional Dollars (12.34)
(O Whole numbers of cents (1234)

rl
Status ISSUED - for ISSUED
STOPPED - for STOPPED
VOIDED - for VOIDED
(] Account Number?
O Issuance Date?

0 Payee Name’

O

Company Name

Save ’ Place the cursor over this label for more information

8. Creating the Issuance Template to the Exported Information from QuickBooks:
a. Template Name

Create a name for the template using information that will allow the user to easily identify this template in
the future. For this example, the template name is QuickBooks Export Type 1.
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Template Name

QuickBooks Export Type 1

File Type?

- select file type

Template Status

v Active v

b. File Type

Select the appropriate file type based on the file type used to save the Excel document. For this example,

the file type will be Excel Workbook.

Template Name

QuickBooks Export Type 1

Number of Header Rows’

0

Multi-Line Payee Name Separator: ?

File Type?

Excel 97-2003 Workbook v

- select file type

Comma Separated

Excel 97-2003 Workbook
Fixed Width

Pipe Separated
Semi-colon Separated
Tab Separated

Template Status

Active v

Template Level’

Client v

c. Template Status

The Template Status drop-down menu defaults to Active status. Leave the status as Active.

Template Name

QuickBooks Export Type 1

Number of Header Rows’

File Type’

Excel Workbook

Number of Footer rows’

Template Status

v Active v

Inactive

d. Number of Header Rows

Refer to the Excel file that was created. A Header Row will be any row above the check information that
does not contain actual check information for presentment in the Positive Pay Module. For this example, the
header rows have been highlighted yellow. The number of header rows should be 2 in the template.
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[a] B |clo E [F| G |H 1 J K [L M N ] Pl Q A

1 | Type Date Ilu_m Name Memo Split Amount
2 | Pinnacle Bank

3 | Bill Pmt -Check 0712472020 '0100 Eastside Utility District Accounts Payable -234.74
4 | Check 07/24/2020 '0101 Citibusiness Platinum Credit Cards -13.26
= Check 07124/2020 'EIIDE American Express American Express Buginess Gold -3,701.19
6 | Check 07124/2020 '0103 Lowes Credit Cards -4,933.02
7 | Check 0712472020 ’6104 Pinnacle Bank (v) -SPLIT- -3,883.24
8 | Bill Pmt -Check 07/24/2020 'DIGS Eastside Utility District Accounts Payable -143.18
9 | Check 07/24/2020 'EIIDE Citibusiness Platinum Credit Cards -1.416.38
10 Check 0712472020 ’010? Lowes Credit Cards -3,128.60
11|  Total Pinnacle Bank -17,423.61
12 _TOTAL -17,423.61

e. Number of Footer Rows

Refer to the Excel file that was created. A Footer Row will be any row below the check information that does
not contain actual check information for presentment in the Positive Pay Module. For this example, the
footer rows have been highlighted yellow. The number of footer rows should be 2 in the template.

Al B cp| B F| 6 |H_ 1) K || M N ° P Q

1 | Type Date Nu_rn Name Memo Split Amount
2 | Pinnacle Bank

3 | Bill Pmt -Check 07/2412020 '01 00 Eastside Utility District Accounts Payable =234 74|
4| Check 07/2412020 '0101 Citibusiness Platinum Credit Cards -13.28
5 | Check 07/24/2020 '0102 American Express American Express Business Gold -3,701.19|
6 | Check 07/2412020 '01 03 Lowes Credit Cards -4,933.02|
7 Check 07/24/2020 '01 04 Pinnacle Bank (v) -SPLIT- -3,853.24
8 | Bill Pmt -Check 07/242020 '01 0s Eastside Utiity District Accounts Payable -143.18
9 | Check 0772412020 '0106 Citibusiness Platinum Credit Cards -1,416.38)
10 | Check 0772412020 rl2|1 o7 Lowes Credit Cards -3,128.60
11 | Total Pinnacle Bank -17,423.61
12 |TOTAL -17,423.61

f. Template Level
The default value of Client will be presented and will not allow a different selection to be made.
g. Multi -Line Payee Name Separator

This feature is not currently available for items exported out of QuickBooks.
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Template Name File Type’ Template Status

QuickBooks Export Type 1 Excel Workbook v Active v
Number of Header Rows’ Number of Footer rows’ Template Level’

2 2 Client v

Multi-Line Payee Name Separator: ’

h. File Mapping

i.  Serial Number
1. Enter the column number that the check number/serial number is presented in the Excel
document. For this example, the Num column is highlighted yellow. The column number for
Num should be 9 in the template.

[a] B el E Jf| 6 |1 |y K L M IN| ) P Q A
1 | Type Date Nu_m Name Memo Split Amount
2 | Pinnacle Bank
3 Bill Pmt -Check 07/24/2020 'EHDEI Eastside Utility District Accounts Payable -234.74
4 Check 07/24/2020 'EIIO1 Citibusiness Platinum Credit Cards -13.26
= | Check 07/24/2020 '0102 American Express American Express Business Gold -3,701.19
6 | Check 07/24/2020 '0103 Lowes Credit Cards -4,933.02
i | Check 07/24/2020 'EI104 Pinnacle Bank (v) -SPLIT- -3,853.24
8 | BilPmt-Check  07/242020 0105  Eastside Utity District Accounts Payable -142.18
9 | Check 0772472020 0106 Ctibusiness Platinum Credit Cards -1,416.38
10 | Check 07/24/2020 'EI107 Lowes Credit Cards -3,128.60
11|  Total Pinnacle Bank -17,423.61
12 | TOTAL w
ii. Amount
Enter the column number that the amount is presented in the Excel document. Select fractional dollars
if the dollars and cents are separated by a decimal. If the dollars and cents are not separated by a
decimal, select whole numbers of cents. For this example, the Amount column is highlighted yellow. The
column number for Amount should be 17 in the template.
_A. B :ClD. E _F_ G _H_ I .J‘ K .L M N_ 0 _P_ Q |
1 Type Date Nu_rn Name Memo Split Amount
2 | Pinnacle Bank
3 Bill Pmt -Check 0712412020 'D1ﬂ0 Eastside Utility District Accounts Payable -234.74
4 Check 07242020 0101 Citibusiness Platinum Credit Cards 1326
= Check 07/24/2020 ’0102 American Express American Express Business Gold -3,701.19
6 | Check 0772472020 '0103 Lowes Credit Cards -4,933.02
7| Check 077242020 0104  Pinnacke Bank (v) -SPLT- 385324
8 BilPmt-Check  07/242020 0105  Eastside Utility District Accounts Payable -143.18
9 | Check 07/24/2020 '0106 Citibusiness Platinum Credit Cards -1,416.38
10 | Check 07/24/2020 ’0107 Lowes Credit Cards -3,128.60
1 | Total Pinnacle Bank -17,423.61
12 TOTAL -17,423.61
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iii. Status

Remove the checkmark from this box. The export from QuickBooks does not contain this information. The
user can add this information manually if they choose to. If the column is added, the box will need to
remain checked, and the column number will need to be entered for the Positive Pay system to accurately
read it. For this example, the Status field is not being used.

File Mapping
Add  Input Field’ File Column’ Field Format
Serial Number 9
Amount’ 17 - @ Fractional Dollars (12.34)
O Whole numbers of cents (1234)
0 Status’ (0 Treat Negative Amount As Void’

Issuance with $0 amount will be treated as Void

If the Status box is unchecked, the user should be aware that any issuance loaded with negative amounts or a
S0 amount will be treated as Void.

iv. Account Number

The exported information from QuickBooks does not include an account number. Leave the box unchecked
and the File Column field blank. For this example, the Account Number field is left blank.

Status’ (0 Treat Negative Amount As Void’

Account Number?

Issuance Date

The Issuance Date is located in the “Date” column in the Excel document. The user must check the box and
enter the column number for the system to read the issuance date correctly. For this example, the Date
column is highlighted yellow. The column number for Issuance Date should be 7 in the template.
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A B C|D E F G [H 1 |J K M N (o] |P Q
1 | Type Date Ilu_m Name Memo Split Amount
2 | Pinnacle Bank
3 | Bill Pmt -Check 0772452020 '0100 Eastside Utility District Accounts Payable -234.74
4 | Check 077242020 70101 Citibusiness Platinum Credit Cards -13.26
= | Check 0712472020 'D102 American Express American Express Business Gold -3,701.18
6 | Check 0712472020 rD1iJ3 Lowes Credit Cards -4,933.02
7 | Check 0772412020 '0104 Pinnacle Bank (v) -SPLIT- -3,853.24
2 Bill Pmt -Check 0772472020 'D1l]5 Eastside Utilty District Accounts Payable -143.18
9 | Check 07/24/2020 0106 Citibusiness Platinum Credit Cards -1,416.38
10 | Check 0772472020 '0107 Lowes Credit Cards -3,128.60
1 Total Pinnacle Bank -17,422.81
12 | TOTAL -17,423.61

Payee Name

If the Client is set up to use Payee Positive Pay, the user will need to select the box and enter the column
number for the column labeled “Name” in the Excel report. For this example, the Name column is
highlighted yellow. The column number for Payee Name should be 11 in the template.

A B C|D E F G H 1 |J K % o} P Q H

1 Type Date Num Name Memo Split Amount
2 Pinnacle Bank

3 Bill Pmt -Check 07/24/2020 '01 oo Eastside Ulility District Accounts Payable -234.74
4 Check 0T/24/2020 '01 01 Citibusiness Platinum Credit Cards -13.28
5 Check 07/24/2020 '01 o2 American Express American Express Business Gold -3,701.1%
6 Check 07/24/2020 '01 03 Lowes Credit Cards -4,933.02
7 Check 07/24/2020 '01 04 Pinnacle Bank (v) -SPLIT- -3,853.24
8 Bill Pmt -Check 07/24/2020 '01 05 Eastside Utility District Accounts Payable -143.18
] Check 07/24/2020 '01 06 Citibusiness Platinum Credit Cards -1,416.38
10 Check 07/24/2020 '01 o7 Lowes Credit Cards -3,128.60
11 Total Pinnacle Bank -17,423.61
12 |TOTAL -17,423.61

Additional Issue Fields

Additional issue fields are available for client use to allow clients to record any additional information into
an issuance file to be used for historical or reconciliation purposes. In the example below, the client has

additional issue fields configured: Company Name, Invoice, and Address. For the purposes of Export from
QuickBooks, the user should disregard these fields as they do not apply to the export process.
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File Mapping
Add  Input Field’ File Column? Field Format
Serial Number 9
Amaount? 17 @ Fractional Dollars (12.34)
O Whole numbers of cents (1234)

D Status’ [J Treat Negative Amount As Void®
O Account Number?
Issuance Date’ 7
Payee Name’

| 1| g

O Company Name

O Invoice
O Address
save ‘- Place the cursor over this label for more information

Click the Save button. A success message appears, and the user will be returned to the Issuance Templates
page. The new issue template will display in the list of templates.

B. Exporting from QuickBooks Reports

1. From QuickBooks, select Reports on the Tool Bar.
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Repon Center
Memorized Reports »
Scheduled Reports »
Commented Reports
Company Snapshot
Process Multiple Repors
Company & Einancial »
® @ Customers & Receivables »
i My Company Enter Bills fklka g
__ Jobs, Time & Mileage 4
-’-\ inc Tracker Vendors & Payables »
Employees & Payroll »
‘ Bill Tracker Banking .
gt Accountant & Taxes »
g Calendar
Budgels »
@ snapshots Lst :
Contributed Reports »
B My Shortc... Advanced Reports
B View Balanc... Create Custom Reports Y Re
M Run Favorite Reports Invoices Payn
B Open Windo... Transaction History
Transaction Journal
Statemew. . e

2. Select Banking from the drop-down menu and click Check Detail from the Banking sub-menu.

= FEile Edit View Lists Favorites Company Customers Vendors Employees Banking Gl Window Help Special Offers

Report Center
) Memorized Reports 3
Scheduled Reports 3

Commented Reports
Company Snapshot

My Shortcuts
4 Process Multiple Reports
A Home Company & Financial
y @ Customers & Receivables % %
‘i’ My Company Sales

Enter Bills PayBills  MNew: Business

»
»
»
Jobs, Time & Mileage » Loans
»
»
»

¥ Income Tracker

Vendors & Payables
Employees & Payroll

Bl Bil Tracker = E .

Calendar Accountant & Taxes l  CheckDetail
Calenc
Budgets »  Missing Checks
\ Snapshots List »  Reconciliation Discrepancy
Previ e
Contributed Reports Previous Reconciliation
@ my shortc... Advanced Reports
= gl
B View Balanc... Create Custom Reports * | Receive
Invoices Payments

M Run Favorite Reports

B open windo. Transaction History @

Transaction Journal
Statemau. Ve (e Refund
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The Check Detail Report will display.

Customine Report Commant on Report Mamarige Prinf * E-majl * Excel v Hide Header Rafrash
Dates * From DS042020 W To O7H02020 B SonBy Default -
Show | Applied Fillers
549 PM Castlerock Leasing, LLC.
s Check Detail
May 4 through July 10, 2020
Type Hum Cate Hamae Iem Actount Paid Ammount Original Amount
Check LS S hrier ] Aumenican Expre... Pnmnache Bank A3
Amarican Express -1.30 130
TOTAL -1.30 130
b Check OEAEFHY Amanican Expre... Pinnache Bank = 0000 o
Amarican Exphess +1.000.00 1.000.00
TOTAL -1,000.00 1,000.00

a. Select the Date drop-down menu to choose a specific date or date range for the check items to display in the
report. Based on the range that is selected, check items that can be displayed can be for a specific date, a
specific quarter, month or even a date range that the user selects.

Customize Report Comment on Report Share Template

Memorize Print v E-maill v Excel v

pates LI - Fom 05042020 B To 07/10/2020 [ SortBy Default

Hide Header

Refresh

This Fiscal Quarter -

This Fiscal Quarter-to-date

Show

This Fiscal Year

This Fiscal Year-to-Last Month
This Fiscal Year-to-date
Yesterday

Last Week

Last Week-to-date

Last Month

Last Month-to-date

05/04/2020

Last Fiscal Quarter

Last Fiscal Quarter-to-date 05/05/2020
Last Fiscal Year

Last Fiscal Year-to-date

Next Week

Next 4 Weeks

Next Month

Next Fiscal Quarter

05/06/2020

Next Fiscal Year

v

Castlerock Leasing, LLC.
Check Detail
May 4 through July 10, 2020
Name

Item Account

American Expre... Pinnacle Bank

American Express

American Expre... Pinnacle Bank

American Express...

Pinnacle Bank

David - Draws

Paid Amount

-1.30

Original Amount

-1.30

1.30

-1.30

-1,000.00

-1,000.00 4

1.30

1,000.00

-1,000.00

-3,000.00

-3,000.00

1,000.00

3,000.00

-3,000.00

3,000.00

b. Click Customize Report button. The Modify Report screen displays.
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Modify Report: Check Detail

Display Filters Header/Footer Fonts & Mumbers
REPORT DATE RANGE

Dates *  The date range you specify in the From and To fields

From 05/04/2020 B To 07/10/2020 &

COLUMN S
Search Columns Sortpy  Default -
S @ Ascgnding order 2
(left margin} A Sortin " Descending order 1
Trans # l
< Type
Entered/Last Modified
Last modified by
v Date
4 Num Advanced...
Put a check mark next to each column
v that you want to appear in the report. Revert

c. Select the Filters tab.

Modify Report: Check Detail ]

Display Filters HeaderFooter  Fonts & Numbers

CHOOSE FILTER CURRENT FILTER CHOICE S

Search Filters Account FILTER SET TO

e Account All bank accounts
— { Al bank accounts ¥ &

o ' Include split detail? Dat p—

‘Aglng © No ate usto

% Amount @ Yes TransactionType |Multiple Transaction T...
i O i i

iBilIing Status For detail accounts matching

}Class -

{ v

Remove Selected Filter
ACCOUNT FILTER

Choose the types of accounts or a specific account from the
drop-down list. Indicate whether or not you want split detail
to appear in the report (Balance Sheet accounts only).

Tell me more...
Revert

d. Inthe listing of Filters, select Account from the drop-down menu.
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i.  Select All Bank Accounts to pull all checks issued from all bank accounts for which the user has

QuickBooks access.

Modify Report: Check Detail P hail v

Display

CHOOSE FILTER

Eilters Header/Footer ~ Fonts & Numbers Default

CURRENT FILTER CHOICES

Search Filters

Account
Aging
Amount
Billing Status

Class

ACCOUNT FILTER

Choose the types of accoun :
drop-down list. Indicate whe Al 3ccounts receivable

to appearinthe report (Bala  Ajj other current assets

Account FILTER ! SET TO ing, L
Account All bank accounts tail
|All bank accounts -
A Amanint «=nNn v 10. 2|
All accounts =
Multiple accounts... '

All balance sheet accounts
v All assets
All current assets

All bank accounts

All fixed assets
All other assets

ii.  Select asingle Bank Account to pull checks issued from a single bank account.

Display
CHOOSE FILTER

Search Filters

Account
Aging
Amount
Billing Status
Class

ACCOUNT FILTER

Choose the types of accoun

drop-down list Indicate whe Millennium Bank Bank

to appearin the report (Bala  accounts Receivable Accounts Receivable
Loans Receivable Other CurrentAsset
Inventory Asset Other CurrentAsset
Undeposited Funds Other CurrentAsset

Modify Report: Check Detail P hail v

Filters Header/fFooter  Fonts & Numbers Default

CURRENT FILTER CHOICES

Account EILTER SET TO sing, U
Account Pinnacle Bank etail
- [Pinnacle Bank b T =non v 10. 2
All alp and sales tax A
Current assets and expenses
AllAR and AP

All non-posting accounts
v Allowed for 1099s

Pinnacle Bank Bank

iii.  Include Split Detail?, click the button next to “No”.

Al
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Meodify Report: Check Detail x

Display Filters HeaderFooter  Fonts & Numbers

CHOOSE FILTER

CURRENT FILTER CHOICES
Search Filters Account FILTER : SET TO
= Account Pinnacle Bank

aehd Pinnacle Bank -
Account - Amount <=0.00

i il?

e ' Include split detail? Date P
Amount P EYe.:; Detail Level Summary only
Billing Status © For detail accounts matching TransactionType |Multiple Transaction T...

-

Class

Remove Selected Filter
ACCOUNT FILTER

Choose the types of accounts or a specific account from the

drop-down list Indicate whether or not you want split detail
to appear in the report (Balance Sheet accounts only).

Tell me more...
Revert

iv. Under Current Filter Choices, select Detail Level, and then click the Remove Selected Filter button.

Modify Report: Check Detail x

Display Filters Header/Footer Fonts & Numbers

CHOOSE FILTER CURRENT FILTER CHOICES

Search Filters Detail Level

‘Plnnade Bank
<=0.00

FILTER o All
Customer Type ® Summary only

i ) All except summary D o —

Detail Level etail Level Summary only

Due Date ansactionType |Multiple Transaction T... |
Entered/Modified

Remove Selected Filter
DETAIL LEVEL FILTER

Choose whether to show or hide the detail lines for each
transaction. Choose ‘Summary only to exclude detail lines

Tell me more...
Revert

V. Select Transaction Type from the Filter menu. Select Multiple Transaction Types from the Transaction
Types submenu.
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Modify Report: Check Detail x

Display Filters HeaderFooter  Fonts & Numbers

CHOOSE FILTER CURRENT FILTER CHOICES

Seacniies | TransactionType
FILTER Account Pinnacle Bank
e— Multiple Transaction Types -
Template — = Amount <=0.00
Terms Al Date Custom
TransactionType HUSEle ITan3=cion Tipes TransactionType |Multiple Transaction T.
Vendor Type
. Check
Voided ‘
v Deposit
Invoice Remove Selected Filter

TRAN SACTIONTYPE FILTER
Sales Receipt

Choose the type of transacti
select several fransaction ty P 2yment
Transaction Types.’ Credit Memo
Journal
Credit Card
Bill Revert
CcCard Credit

Bill Credit m Cancel Help
CCard Refund

Vi. From the Select Transaction Type drop-down menu, select the check transactions to appear in the Check
File. For this example, Check and Bill Payment options were selected. Click OK to confirm the transaction
types.

Modify Report: Check Detail

Display =
Select Transaction Types
CHOOSE FILTER
Select the Transaction Types from the “

Search Filterg] list then click OK. i SET TO
FILTER /Check = Eagcol Pinnacle Bank
Template Deposit " ==0.00
Terms Invoice Custom

TransactionTy | Sales Receipt
Vendor Type Payment
Voided Credit Memo

Remove Selected Filter

TRAN SACTIONTYPEFITTER
Choose the type of transaction from the drop-down list. To

select several transaction types, choose 'Multiple
Transaction Types.’

Tell me more...
Revert

e. From the Modify Report screen, select OK to proceed. The requested changes to the report will display.
From the QuickBooks toolbar, click the Excel drop-down menu and select Create New Worksheet.

111



Positive Pay
User Guide

i

Customize Report Comment on Report Share Template Memorize Print * E-mail ~ Excel « Hide Header Refresh
Dates  Custom - me[psm:zozo B | To 07/10/2020 B SortBy Default IR AL

Update Existing Worksheet
Show | Applied Filters

8:47 PM Castlerock Leasing, LLC.
071020 Check Detail
May 4 through July 10, 2020
Type Num Date Name ltem Account Paid Amount Original Amount
» Check 05/04/2020 American Expre... Pinnacle Bank -1.30 4

f. The Send Report to Excel pop-up window appears. Select Create New Worksheet > In New Worksheet and
click the Export button to continue.

Customize Report Comment on Report Share Template Memorize Print * E-mail v Excel v Hide Header Refresh

Dates Custom *  From 05042020 B8 | To 07/10/2020 B8 Sod By Defs
- Send Report to Excel

Show | Applied Filters

8:47 PM WHAT WOULD YOU LIKE TO DO WITH THIS REPORT?
0710120
@® in new workbook
T Nu . Original Amount
b ) in existing workbook <
) Update an existing worksheet How it works
» Check -1.30 4
" Replace an existing worksheet
1.20
) Create a comma separated values (.csv) file —
TOTAL 1.30
Check -1,000.00
1,000.00
TOTAL Advanced... 1,000.00
Check -3,000.00
TUTRrTOTIYTY 3,000.00
TOTAL -3,000.00 3,000.00

g. Excel will open and the Excel file will populate. Within the Excel file, remove all rows that are blank under
the column headers “Type” and/or “Num”.
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File Home Insert Page Layout Formulas Data Review View Help Acrobat QuickBooks
M E; Calibri Jn AR =E= = ‘%‘- EEbWrapTut General ~ @ % @ @
B I U-~ v | Mo Ao = = 3= M & Center v . 9 &0 .00 Conditional Formatas Cell Insert
4 - - - SIge S LEnier $ % el Formatting~ Table ~ Styles ~ =
Clipboard & Font £} Alignment ] Number & Styles
D15 = 5
| A B | € ) E| F G H 1 J K L M N 9 P . Q
1] Type Num Date Name Item Account Paid Amount  Original Amount
2 | )
3 | Check '0001 05/13/2020  Citibusiness Platinum |Pinnacle Bank -45.09
4 | Check 73002 06/01/2020 Pinnacle Bank (v) :Pmnacle Bank -3,751.35
i Check '0003 06/03/2020 American Express Pinnacle Bank -39.00
| A )
6 | Check 0004 06/15/2020  Citibusiness Platinum | Pinnacle Bank -13.26
7 Check VOGOS 06/16/2020 American Express | Pinnacle Bank -3,701.19
8 | Check '0006 06/16/2020 American Airlines VISA fﬁnnacle Bank -233.71
a | Check ’600? 06/16/2020 Lowes | Pinnacle Bank -4,933.02
10 | Check '0008 07/01/2020 Pinnacle Bank (v) :Pinntcla Bank -3,853.24
1 | Check '0009 07/06/2020  American Express | Pinnacle Bank -1,000.00
12 | Bill Pmt -Check ENHG 05/04/2020 Eastside Utility District 'Pinnacle Bank -207.62
13 Bill Pmt -Check 'CNIH 06/01/2020 _ Eastside Utility District \ Pinnacle Bank -234.74
h. Remove all blank columns.
AutoSave (@ oft) = Book2 - Excel P Search -
File Home Insert Page Layout Formulas Data Review  View Help Acrobat QuickBooks
an A Calibri Y1 AN == = v EBWrap Text General v ﬁ @ @
@~ .
Paste B I U M. A ===|== M 0, <0 .00 | Conditional Formatas Cell
=~ e hd = = = £ 2= | B Merge & Center ~ ~ !
- ¥ - B Merg $ % 9 T Formatting v Table v Styles
Clipboard Font (] Alignment (] Number ] Styles
110 e e
A B (e D = F G H | J
1 Type Num Date Name Account Original Amount
2
r
3 |Check 0001 05/13/2020 Citibusiness Platinum Pinnacle Bank -45.09
r
4 |Check 0002 06/01/2020 Pinnacle Bank (v) Pinnacle Bank -3,751.35
r
5 Check 0003 06/03/2020 American Express Pinnacle Bank -39.00
r
6 |Check 0004 06/15/2020 Citibusiness Platinum Pinnacle Bank -13.26
r
7 Check 0005 06/16/2020 American Express Pinnacle Bank -3,701.19
r
8 |Check 0006 06/16/2020 American Airlines VISA  Pinnacle Bank -233.71
r
9 |Check 0007 06/16/2020 Lowes Pinnacle Bank -4,933.02
r |:|
10 |Check 0008 07/01/2020 Pinnacle Bank (v) Pinnacle Bank -3,853.24 ]
11 |Check 7)009 07/06/2020 American Express Pinnacle Bank -1,000.00
r
12 |Bill Pmt -Check 0010 05/04/2020 Eastside Utility District Pinnacle Bank -207.62
r
13 |Bill Pmt -Check |0011 06/01/2020 Eastside Utility District Pinnacle Bank -234.74

i. Select File > Save As and save the workbook.
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a.Choose the File Name

b.Choose the Format. The file format for this file must be Comma Separated, Excel 97-2003 Workbook or
Excel Workbook.

ﬂ Save As

&« v 4 » ThisPC » Documents > New folder (2)

v & Search New folder (2)

Organize * New folder

v @
~
A

[ This PC

8 30 Objects

Date modified

No items match y

Name Type

our search.

I Desktop

] Documents
4 Downloads

D Music

=/ Pictures

B Videos

- 05 (C)

== ACH Alert Share

% Network v

Size

File name: ‘ Check Report 05012020 through 07102020.x1sx

Save as type: | Excel Workbook (*.xlsx)

j.  After saving, close the Excel Workbook.

From the Client Dashboard, a user can navigate to the Positive Pay Module by clicking Change Module > Positive

End of Day Cut-Off Time: Friday 12:00 PM EST

Change Module ~

ACH Filter Debit
Positive Pay
EDI TransAlert
ACH Filter Credit

Pay
Dashboard ~ #'Perform = JiReports »  i= Transaction View
ACH Filter Credit

From the Positive Pay module, select Manage > Issue Templates to create an issue template. This will allow the

user to map the exported information from QuickBooks so that the file is read correctly when uploaded to
Positive Pay. The user will also be able to save this template for use in future issuance file uploads.
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Positive Pay £ Manage ~ # Perform » i Reports ~ = View ~
Issue Templates

Welcome

Please use the above menu to select an action

6. The Issuance File Templates page displays. This page lists the saved Issue File Templates available for the Client
to use and allows the user to create a new template for use. Select Create New Template.

Template File Type
Delete Filter by Template Filter by File Type Edit/View

2011 Regression C Comma Separated >
csv Comma Separated @
sVt Comma Separated @
DBFI Fixed Width Fixed Width ®
Excel 1 Excel Workbook >
Excel 97-2003 Workbook Excel 97-2003 Workbook @
Quickbooks Type 1 Excel Workbook @

m] 2008 Regression Comma Separated ’

m] 2008 Regression A Excel Workbook y

7. The Create New Template screen appears.
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Create New Template

Template Name File Type’ Template Status
- select file type v Active v

Number of Header Rows’ Number of Footer rows’ Template Level’
0 0 Client v

Multi-Line Payee Name Separator: ’

Do not use a character as a separator if
that character will ever be presentin a
Payee Name. Allowed characters in
brackets[;|.-_/]

File Mapping
Add  InputField’ File Column’ Field Format
Serial Number

Amount’ @ Fractional Dollars (12.34)
© Whole numbers of cents (1234)

?
Status ISSUED - for ISSUED
£,
STOPPED - for STOPPED
£
VOIDED - for VOIDED
O Account Number’
m] Issuance Date’

0 Payee Name’

Save ’- Place the cursor over this label for more information

8. Creating the Issuance Template to the Exported Information from QuickBooks:

a. Template Name
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Create a name for the template using information that will allow the user to easily identify this template in
the future. For this example, the template name is QuickBooks Export Type 2.

Template Name File Type’ Template Status
QuickBooks Export Type 2° - select file type w Altive b
b. File Type

Select the appropriate file type based on the file type used to save the Excel document. For this example,
the file type will be Excel Workbook.

Template Name File Type’ Template Status

QuickBooks Export Type 2° - select file type v Active v

- select file type

Comma Separated

0 Excel 97-2003 Workbook
Excel Workbook

Fixed Width

Pipe Separated
Semi-colon Separated
Tab Separated

Number of Header Rows’ Template Level’

Client v

Multi-Line Payee Name Separator:

c. Template Status

The Template Status drop-down menu defaults to Active status. Leave the status as Active.

Template Name File Type’ Template Status

QuickBooks Export Type 2° - select file type A Active v

? ?
Number of Header Rows’ Number of Footer rows’ ‘ Inactive

d. Referto the Excel file that was created. A Header Row will be any row above the check information that
does not contain actual check information for presentment in the Positive Pay Module. For this example, the
header rows have been highlighted yellow. The number of header rows should be 2 in the template.
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1 Type Num Date Name Account Original Amount
2 4

3 ‘Check '0001 05/13/2020 Citibusiness Platinum Pinnacle Bank -45.09
4 ‘Check '0002 06/01/2020 Pinnacle Bank (v) Pinnacle Bank -3,751.35
5 ‘Check '0003 06/03/2020 American Express Pinnacle Bank -39.00
6 ‘Check '0004 06/15/2020 Citibusiness Platinum Pinnacle Bank -13.26
7 ‘Check '0005 06/16/2020 American Express Pinnacle Bank -3,701.19
8 Check '1'1006 06/16/2020 American Airlines VISA  Pinnacle Bank -233.711
9 |Check '0007 06/16/2020 Lowes Pinnacle Bank -4,933.02
10 |Check 7)003 07/01/2020 Pinnacle Bank (v) Pinnacle Bank -3,853.24
11 |Check '0009 07/06/2020 American Express Pinnacle Bank -1,000.00
12 |Bill Pmt -Check '0010 05/04/2020 Eastside Utility District Pinnacle Bank -207.62

e. Refer to the Excel file that was created. A Footer Row will be any row below the check information that
does not contain actual check information for presentment in the Positive Pay Module. For this example, the
footer rows have been highlighted yellow. The number of footer rows should be 2 in the template.

. A | B _ C D E | F [
1 Type Num Date Name Account Original Amount
2 4
3 |Check '0001 05/13/2020 Citibusiness Platinum Pinnacle Bank -45.09
4 ‘Check '0002 06/01/2020 Pinnacle Bank (v) Pinnacle Bank -3,751.35
5 ICheck 1"003 06/03/2020 American Express Pinnacle Bank -39.00
6 'Check '0004 06/15/2020 Citibusiness Platinum Pinnacle Bank -13.26
7 ‘Check '0005 06/16/2020 American Express Pinnacle Bank -3,701.19
8 |Check '0006 06/16/2020 American Airlines VISA  Pinnacle Bank -233.711
9 ‘Check '0007 06/16/2020 Lowes Pinnacle Bank -4,933.02
10 ‘Check '0008 07/01/2020 Pinnacle Bank (v) Pinnacle Bank -3,853.24
1 |Check '0009 07/06/2020 American Express Pinnacle Bank -1,000.00
12 ‘Bill Pmt -Check '0010 05/04/2020 Eastside Utility District Pinnacle Bank -207.62
13 IBiII Pmt -Check '0011 06/01/2020 Eastside Utility District Pinnacle Bank -234.74
14 |Bill Pmt -Check rCNZH.? 07/02/2020 Eastside Utility District Pinnacle Bank -143.18
15 |
16 |Total -18,155.40
17

f. Template Level

The default value of Client will be presented and will not allow a different selection to be made.
g. Multi-Line Payee Name Separator.
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This feature is not currently available for items exported out of QuickBooks.

Template Name File Type’ Template Status

QuickBooks Export Type 2° Excel Workbook v Active v

Number of Header Rows’ Number of Footer rows’ Template Level’

2 2 Client v

Multi-Line Payee Name Separator: ’

h. File Mapping
i. Serial Number
1. Enter the column number that the check number/serial number is presented in the Excel

document. For this example, the Num column is highlighted yellow. The column number for
Amount should be 2 in the template.

_ A B C D E F
| 1 Type Num Date Name Account Original Amount _
2
3 |Check IEDI.'DCH 05/13/2020 Citibusiness Platinum Pinnacle Bank -45.09
4 | Check '0002 06/01/2020 Pinnacle Bank (v) Pinnacle Bank -3,751.35
5 |Check '0003 06/03/2020 American Express Pinnacle Bank -39.00
6 !Check '0004 06/15/2020 Citibusiness Platinum Pinnacle Bank -13.26
il jCheck r0005 06/16/2020 American Express Pinnacle Bank -3,701.19
8 Check r0006 06/16/2020 American Airlines VISA  Pinnacle Bank -233.71
8 Check '6007 06/16/2020 Lowes Pinnacle Bank -4,933.02
10 ‘Check '0008 07/01/2020 Pinnacle Bank (v) Pinnacle Bank -3,853.24
11 !Check '0009 07/06/2020 American Express Pinnacle Bank -1,000.00
12 |Bill Pmt -Check 0010 05/04/2020 Eastside Utility District  Pinnacle Bank -207.62
13 |Bill Pmt -Check '0011 06/01/2020 Eastside Utility District Pinnacle Bank -234.74
14 _. Bill Pmt -Check '0012 07/02/2020 Eastside Utility District Pinnacle Bank -143.18
15
16 | Total -18,155.40

ii. Amount

1. Enter the column number that the amount is presented in the Excel document. Select fractional
dollars if the dollars and cents are separated by a decimal. If the dollars and cents are not
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separated by a decimal, select whole numbers of cents. For this example, the Amount column is

i

highlighted yellow. The column number for Amount should be 6 in the template.

[ A | B C | D | F |
1 _ Type Num Date Name Account Original Amount
2 |
3 |Check rOOIH 05/13/2020 Citibusiness Platinum Pinnacle Bank -45.09
4 ICheck '0002 06/01/2020 Pinnacle Bank (v) Pinnacle Bank -3,751.35
5 |Check '6003 06/03/2020 American Express Pinnacle Bank -39.00
6 ICheck '0004 06/15/2020 Citibusiness Platinum Pinnacle Bank -13.26
7 ICheck '0005 06/16/2020 American Express Pinnacle Bank -3,701.19
8 |Check I|'l'ZbCMZNS 06/16/2020 American Airlines VISA  Pinnacle Bank -233.711
9 |Check 'tIOOT 06/16/2020 Lowes Pinnacle Bank -4,933.02
10 |Check '0008 07/01/2020 Pinnacle Bank (v) Pinnacle Bank -3,853.24
11 |Check '0009 07/06/2020 American Express Pinnacle Bank -1,000.00
12 |Bill Pmt -Check 'l.'l010 05/04/2020 Eastside Utility District Pinnacle Bank -207.62
13 lBilI Pmt -Check '0011 06/01/2020 Eastside Utility District Pinnacle Bank -234.74
14 .Bil! Pmt -Check '0012 07/02/2020 Eastside Utility District Pinnacle Bank -143.18
15 |
16 ITotal -18,155.40

iii. Status

Remove the checkmark from this box. The export from QuickBooks does not contain
this information. The user can add this information manually if they choose to. If the
column is added, the box will need to remain checked and the column number will
need to be entered for the Positive Pay system to accurately read it. For this
example, the Status field is not being used.

File Mapping

Amount’

0 Status’

Add  Input Field’

Serial Number

File Column’ Field Format

@ Fractional Dollars (12.34)
) Whole numbers of cents (1234)

() Treat Negative Amount As Void®

If the Status box is unchecked, the user should be aware that any issuance loaded with negative
amounts or a $0 amount will be treated as Void.
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iv. Account Number

1. The exported information from QuickBooks does not include an account number. Leave the box
unchecked and the File Column field blank. For this example, the Account Number field is left
blank.

0O Status’ [J Treat Negative Amount As Void’

Account Number?

V. Issuance Date

1. The Issuance Date is located in the “Date” column in the Excel document. The user must check
the box and enter the column number for the system to read the issuance date correctly. For
this example, the Date column is highlighted yellow. The column number for Issuance Date
should be 3 in the template.

[ A | B . C D E | F .
_ 1 Type Num Date Name Account Original Amount
2 | |
2! lCheck 7)001 05/13/2020 Citibusiness Platinum Pinnacle Bank -45.09
4 .Check '0002 06/01/2020 Pinnacle Bank (v) Pinnacle Bank -3,751.35
5 |Check '6003 06/03/2020 American Express Pinnacle Bank -39.00
6 ICheck '0004 06/15/2020 Citibusiness Platinum Pinnacle Bank -13.26
7 |Check '0005 06/16/2020 American Express Pinnacle Bank -3,701.19
8 |Check 'CIODG 06/16/2020 American Airlines VISA  Pinnacle Bank -233.71
9 .Check '000? 06/16/2020 Lowes Pinnacle Bank -4,933.02
10 |Check 'o008 07/01/2020 Pinnacle Bank (v) Pinnacle Bank -3,853.24
11 |Check 7)009 07/06/2020 American Express Pinnacle Bank -1,000.00
12 IBiil Pmt -Check 'oo1o 05/04/2020 Eastside Utility District Pinnacle Bank -207.62
13 |Bill Pmt -Check '0011 06/01/2020 Eastside Utility District Pinnacle Bank -234.74
14 IBiII Pmt -Check 7]012 07/02/2020 Eastside Utility District Pinnacle Bank -143.18
15 | .
16 Total _ -18,155.40
Vi. Payee Name

1. If the Customer is set up to use Payee Positive Pay, the user will need to select the box and enter
the column number for the column labeled “Name” in the Excel report. For this example, the
Name column is highlighted yellow. The column number for Payee Name should be 4 in the
template.
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A ' B C D E F

1 Type Num Date Name Account Original Amount
2 {

3 |Check '60-01 05/13/2020 Citibusiness Platinum Pinnacle Bank -45.09
4 |Check TJ-D-DE 06/01/2020 Pinnacle Bank (v) Pinnacle Bank -3,751.35
5 |Check 0003 06/03/2020 American Express Pinnacle Bank 39.00
& ll'.‘het:k 'EHJO-i 06/15/2020 Citibusiness Platinum Pinnacle Bank -13.26
T 1[:het:lc 'EIIDIDB 06M16/2020 American Express Pinnacle Bank -3,701.19
8 |Check 'ﬁmﬁ 06/16/2020 American Airlines VISA Pinnacle Bank -233.M
9 :Chet:k 'Elﬂﬂf 06M6/2020 Lowes Pinnacle Bank -4933.02
10 |Check 'EIWE 07/01/2020 Pinnacle Bank (v) Pinnacle Bank -3,853.24
11 IChecl-: 73009 07/06/2020 American Express Pinnacle Bank -1,000.00
vii.  Additional Issue Fields

i

1. Additional issue fields are available for client use to allow clients to record any additional
information into an issuance file to be used for historical or reconciliation purposes. In the
example below, the client has additional issue fields configured: Company Name, Invoice,
and Address. For the purposes of Export from QuickBooks, the user should disregard these
fields as they do not apply to the export process.
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Create New Template
Template Name File Type’ Template Status
QuickBooks Export Type 2° Excel Workbook ~ Cctive ~
Number of Header Rows’ Number of Footer rows’ Template Level”
2 2 Client ~
Multi-Line Payee Name Separator: 7
File Mapping
Add  Input Field’ File Column’ Field Format
Serial Number 2
Amount? 6 @® Fractional Dollars (12.34)
) Whole numbers of cents (1234)
O Status® [ Treat Negative Amount As Void®
O Account Number?
Issuance Date? 3
Payee Name’ 4 -
O Project #
[ cet - Wi i 0 inf .
Save - Place the cursor over this label for more information

i.  Click the Save button. A success message appears, and the user will be returned to the
Issuance Templates page. The new issue template will display in the list of templates.

Create New Template

Delete

[m]

Template
Filter by Template

csv

st

DEFI Fixed Width

Excel 97-2003 Workbook

CPP1029 Test
QuickBooks Export Type 1

QuickBooks Export Type 2°

File e
Filter by File Type

Comma Separated
Comma Separated
Fixed Width

Excel 97-2003 Workbook

Excel Workbook
Excel Workbook

Excel Workbook

Edit/View

(-4

@ @ o
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C. Loading the QuickBooks Issue File

1. From the Positive Pay Module, select Perform > Issue File Load.

Positive Pay £ Manage = # Perform =

i Repors -

Issue File Load
Manual [ssue Entry

Transaction Approval El CO m e

Please use the above menu to select an action

The Load Check Issuance File page appears.

Issue File Load

Template to Use With Issue File

- select template - v Create New Template

Select template that matches issue file format

3. Select the Template drop-down box to select from a list of existing templates. Select the appropriate template.
For this example, QuickBooks Export Type 2 will be used.
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Issue File Load

Template to Use With Issue File

- select template - v Create New Template

- select template -

csv

csV1

DBFI Fixed Width

Excel 97-2003 Workbook
CPP1029 Test

QuickBooks Export Type 1
QuickBooks Export Type 2°

4. The template selected was created without the Account field enabled. A drop-down box will display so that the
appropriate account can be selected. Select from the list of accounts. For this example, ABC Heating — xxxx1555
will be used.

Issue File Load

Template to Use With Issue File Account’
QuickBooks Export Type 1 v - not selected - v Create New Template
- not selected -
ABC Heating - xxxx5555
View Selected Template Client 6 3rd - 0x1111

Select account and template that matches issue file format

5. The file upload interface will appear. Click the Browse button to select the appropriate file or drag and drop the
file into the box indicated on the interface screen.
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Issue File Load

Template to Use With Issue File Account’

QuickBooks Export Type 1 v ABC Heating - xxxx5555 v Create New Template

View Selected Template

Select one issue file that is in the format of the selected template

Select files...

6. Once the file is selected, it will be displayed in the upload interface.

Issue File Load

Template to Use With Issue File Account’

QuickBooks Export Type 1 v ABC Heating - 00001555 v Create New Template

View Selected Template

Select one issue file that is in the format of the selected template

LN

i CheckFileTest.xdsx @ Remove  ® Upload

7. Click the Upload button to proceed. Once the file has loaded successfully, the Issuance File Status page will
display and will be eligible for editing in the Issue Warehouse.
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< Back to Status CheckFileTest.xIsx

File Status

Queued Processing Processed Approved Complete Deleted

File processing is complete. View list below to see items.

@ View items: 12 Items totaling $18,155.40

Rows 1-120f12.

Account Number Serial Number Amount Payee Name Status Load Date Issuance Date
001555 1 $45.09 Citibusiness Platinum AVAILABLE_FOR_MATCHING 07/22/2020 15:39:24 EDT 05/13/2020
01555 2 $3,751.35  Pinnacle Bank (v) AVAILABLE_FOR_MATCHING 07/22/2020 15:39:24 EDT 06/01/2020
01555 i} $39.00 American Express AVAILABLE_FOR_MATCHING 07/22/2020 15:39:24 EDT 06/03/2020
X0X1555 4 $13.26  Citibusiness Platinum AVAILABLE_FOR_MATCHING 07/22/2020 15:39:24 EDT 06/15/2020
XXxx1555 5 $3,701.19  American Express AVAILABLE_FOR_MATCHING 07/22/2020 15:39:24 EDT 06/16/2020
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